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INTRODUCTION
Technical Support

For Hochiki America technical support, contact Hochiki America at 800.845.6692 or
technicalsupport@hochiki.com. Hochiki technical support is availableMonday through Friday, 6:00AM to
4:00PM, PST.

For VES Fire Detection Systems technical support, contact VES at 800.274.9514 or e-mail techsupport@ves-
network.com. VES technical support is availableMonday through Friday, 9:00 AM to 6:00 PM, EST.

Prior to contacting technical support, have the following information available:

n LE2 Version
n LE2 Database (Refer to the Help Tab for information on locating this information.)
n Panel firmware version
n Copy of NLE file
n Current function of the product
n Expected function of the product
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Overview
Loop Explorer 2 (LE2) is a software program that allows a user to use a computer to program supported
hardwaremanufactured byHochiki America or VES Fire Detection Systems.

This software is intended for use by trained and qualified personnel only. Always perform system testing in
accordance with NFPA requirements after making any programming changes using Loop Explorer 2.
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System Requirements
IMPORTANT! An internet connection is required to download updates to Loop Explorer 2. Either Google Chrome,
Internet Explorer, or Microsoft Edge are required to view theWebHelp.

PC Requirements
Minimum Recommended

Operating System Windows 10 (32 or 64 bit), including all required updates
Processor CPU Intel® Core™ i3 CPU Intel® Core™ i5 64 bit
RAM 512 MB 2GB
Available Disk Space 125MB, plus additional storage space for configuration files
Ports USB 2.0 Port
I / O Devices Keyboard, Mouse, Monitor
Internet Connection Internet connectivity is necessary to perform updates and to take advantage of some

features.
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Requirements
FACP Cable Type Photo
FireNET, FireNET Plus
Elite, Elite RS

Serial Programming Cable
(VES: VF1591-00)
(Hochiki: X187 or S187)

Serial to USB

Keyspan Adapter
(Model USA-19HS)

L@titude, Compas USB Type A to USB Type B

OR 

USB Flash Drive

OR
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INSTALLATION
Before beginning installation, contact the assigned system administrator to obtain a login and temporary
password.

NOTE Internet connection required to download LE2.

1. Navigate and log in to the Virtual Resource website at https://www.virtualresource.global/. After logging into Virtual
Resource for the first time, a new password prompt will appear.

2. Once logged in, select the desired options in the following windows to download an appropriate version of Loop Explorer
2.

Select the desired LE2Option: Site Configuration orAccount Administration.
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Selected the desired option from the available buttons.

Download the desired version of LE2 from the choices presented.

3. Locate the LE2Setup.exe and double-click to run it.

NOTE Depending on the configuration, Windows may give a warning about installing an
unrecognized app. Click More info andRun anyway to continue installation.

4. Follow the instructions on each window to complete the installation and accept the user agreement.
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IMPORTANT! Depending on any installed virus protection software, theremay be additional windows or steps that
must be taken to complete installation.

5. Launch LE2. This can take up to a minute.
6. When LE2 opens, it will prompt an update if the current version is not the latest. Otherwise, the Open Network File

window will appear.

7. Click Create New File to start creating a configuration file.
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Updating LE2
Upon launch, LE2 will prompt an update if the current version is not the latest.

1. To update from the application, click Tools > Edit Preferences > Updates tab.
2. Click Check Now.

3. The Download Application Updates window will appear. Select the desired update and click Get Update Now.

4. Follow the instructions on each window to complete the installation and accept the user agreement.

NOTE When performing an update, LE2 does a complete uninstall before reinstalling the selected update.
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IMPORTANT! Depending on your virus protection, theremay be additional windows or steps that must be taken to
complete installation.

A list of changesmade in each update is available in Virtual Resource under theClient Change Log.
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GUI Overview
This is an overview of the Network View of the LE2GUI. You can findmore information about each section of
GUI in the sections below.

The Tabs and Icon Ribbon are the primary navigation tools in LE2. These are explained in the Tabs section
below. See Tabs for more information. Additionally, each tab has expanded detail in dedicated sections.

l File Tab
l Configure Tab
l Tools Tab
l Help Tab

TheNetwork Tree displays all panels, modules, and devices on the network. Use the + and - to expand and
contract the groups.

The Device Tabs filter themodules displayed.
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Using the Network Tree

Network Site Details
l Site Name. Enter a name for the network. There are
no character limits on this field.

l Master Clock Node. Use the drop-down box to select
the panel whose clock will be used as the master.

l Alarm Verification. Use the drop-down box to select
the desired option. Options are:

l PAS Only - This delays the activation while
staff investigates the source of the fire alarm
signal. This applies only to automatic fire
detection devices (heat, CO).

l Alarm Verification Only - This delays the
activation for a configured amount of time.
This applies to smoke sensors only.

l Pre-Signal or Verification - This combines
Pre-Signal and Alarm Verification.

l PAS or Verification - This combines PAS and
Alarm Verification.

l Pre-Signal Only - The intial alarm signal will
not activate the general fire alarm system.
Subsequent signals will activate the system,

l Retard-Reset-Restart. Select the amount of time to
delay the alarm, between 5-55 seconds.

l Network Communications. Use the drop-down box
to select the baud rate.

l Singapore CP10 Operation. Check the box if the fire
alarm system is being installed in Singapore. A
warning will appear stating that the system will not
meet UL requirements if this option is selected. Check
the box if the system is a Voice System.

Panel Options
l New I/O Module. This opens the New I/O Module wizard.
l Edit Properties. This opens the Panel Configuration window.
l Expand / Collapse All. This will expand or collapse the network tree view.
l Create Loop Emulator File. This is an advanced engineering feature. Contact
your technical support for more information.

l Battery / Cable Length Calculator. This opens the Battery and Cable Length
Calculator.

l Delete. This deletes the panel from the network.
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Loop Options
l New Device This opens the New Device wizard.
l Loop Operations l Move / Copy Loop Devices to > Move

or copy the devices from the current loop
to another loop on the network.

l Convert to Wireless. For future use.
l Create Loop Emulator File. This is an
advanced engineering feature. Contact
your technical support for more
information.

l Get Loop from Panel. For future use.
l Mark All Devices on Loop > This allows
the user to mark all devices on the
selected loop as Installed or Not
Installed.

l Add All Devices on Loop to Favorites.
This adds all devices on the selected
loop to the favorites.

l Delete All Devices on Loop. This
deletes all devices on the loop.

l Expand / Collapse
All This will expand or collapse the network

tree view.

Module Options
Edit Properties. This opens theModule Configuration window.

Expand / Collapse All. This will expand or collapse the network tree
view.

Delete. This will delete the currently-selectedmodule from the
network.

Hochiki America Corporation
Loop Explorer 2 User Guide

Version 1.00 |   June 2021 |   MAN-701
Page 27

User Interface



Device Options
l Edit Properties This opens the New Device wizard.
l Device Operations > l Add to a Cause as an Input / Output >.

A list of existing Cause / Effects will
appear. This will add the device to the
selected Cause / Effect.

l Where Used in Cause and Effects.
This displays a list of Cause/Effects that
use this device.

l Add Device to Favorites. This the
device to the device favorites list.

l Change Address. Select this to change
the device address.

l Copy Device. This opens an Address
selection window. To copy this device,
select the desired address.

l Copy Device (Next Free Address).
This copies the selected device to the
next free address.

l Change Device Type.... This opens the
device selection window. Select the
desired device.

l Mark Device as >. This marks the
device as Installed or Not Installed.

l Data Sheet. If linked, this opens the
device datasheet.

l Expand / Collapse All This will expand or collapse the network
tree view.

l Delete This deletes the selected device from the
network.
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Tabs
File Tab

Icon Label Description

Exit This closes the LE2 application.

Save

This saves changes to the current configuration under the current filename.

NOTE AutoSave can be enabled inEdit Preferences.

New Starts a New Project.

Open Opens an existing project.

Save As... This allows the current configuration to be saved with a new file name.

Import

Opens the Loop Explorer 1 conversion utility.

NOTE Using the Import option can result in data voids in the resulting configuration
file. The recommended procedure for importing a configuration file is to use the
Transfer Configuration procedure.

Export Guide / Graphix /
L@ti-View Data

Opens theSave Filewindow that allows the export of configuration data for the
Guide / Graphix / L@ti-View application.

Generate Reports Opens theGenerate Reportswindow that allows the generation of many
different reports.
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Configure Tab

Icon Label Description

Network This displays the network tree.

New Panel
New Module
New Device

Depending on the selection in the Network Tree, one of these
icons will be displayed in the ribbon. This will open theNew
Panel, New Module, orNew Devicewizard.

System
Manager

This tool allows the configuration of user accounts, user levels,
panel passcode preferences, and function buttonmanagement.1

Quick Config
Quick Config opens a table that displays all SLC devices on the
loop and allows the zone number and location text of each SLC
device to be edited.

ZoneManager

The ZoneManager opens a window with a list of all available
zones on each system. It allows a quick review of the zones and
the inputs and outputs that have been assigned to each zone. It
also allows users to edit zone names, modify zoned devices, and
assign an alarm verification type.

Sensitivity Mgr
This is a configuration tool for making global changes to individual
or multiple sensors of the same type on the network without
modifying each sensor separately.

Group
Manager

COMING SOON
This tool allows a user to add Zones, Inputs, andOutputs into
Groups that can be used in Cause and Effects.

LoopManager
This tool is for making global changes to specific aspects of
SLC devices on each loop on the network without modifying each
device separately.

Cause and
Effect

The Cause and Effect window displays a summary view of all
Cause and Effect relationships on the system. This allows the
creation, deletion, andmodification of Cause and Effects.

Notes
This opens the Notes Editor, which allows the user to add
plaintext notes about the network. Notes are saved in the LE2 .nle
file.

Action
Messages

This window allows the user to add custommessages to be
displayed when an input is activated.
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Icon Label Description

Templates Mgr

This tool allows users to create a customMedia Gateway
SIA/CID central station reporting code table.

NOTE This feature is not available in all configurations.
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Tools Tab

Icon Label Description

Dial Modem This allows users to interface to a serial dialer modem. This can be used to
configure or obtain the event history of a fire alarm system. 2

Transfer Configuration This tool allows the user to connect to a Fire Alarm System to set the time or
import or export a configuration.

Transfer Quiescent Screen This allows the user to transfer a custom quiescent screen from LE2 to the panel.
1

XML Import This tool allows users to import data from an existing configuration or from an
LE2 exported configuration file.1

XML Export This tool allows users to create a configuration file to export to a control unit or as
a backup.1

Panel Event Log The Event log tool can be used to import an existing panel event log from a
control unit to LE2 in order to view or save it on a computer.

Loop Analog Values

Sensors (detectors) on a SLC loop have Analog Values which represent current
value (clean air), last calibrated zero point, and last calibrated fire point. These
Analog Values relate to the health of the sensor. These values can be retrieved
using the Analog Values window.2

Update Panel Firmware This tool is used to update control unit firmware from a firmware file saved locally
on the PC.

Virtual Panel The Virtual Panel tool provides remote access to the display and controls of
connected panel.2

Monitor Mode This tool canmonitor or save event data generated from a control unit’s serial
port for the unit printer.2

Battery Calculator This tool can be used to calculate theminimum battery capacity and the
maximum wire length requirements for their system.

Edit Preferences
This opens a window where the user can setup general preferences, display
options, and check for software updates. All preferences will be saved across
projects.
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Icon Label Description

License The license tool displays the current username and expiration date for the user
license.

Loopback Test This tool allows users to test the connectivity of the transmit and receiver of a
serial cable. 2
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Help Tab

Icon Label Description

View Application Errors This is the application error log that stores error code details encountered in LE2.

View Communication Logs This is the application communication log that stores communication details
between LE2 and connected units.

Hochiki America / VES This will open the website for the appropriate company.

About This window displays information about the current software version and a link to
the software release notes webpage.

1 Not supported on legacy panels.

2Only supported on legacy panels.
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FILE TAB
Click the icon to see detailed information about that toolbar option.

File Commands 36

Import 37

Export Graphix / Guide Data 38

Generate Reports 39
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File Commands
The first several icons on this tab are Exit, Save, New, Open, and Save As... These are standard commands
available in most application and function as expected.
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Import
There are two ways to import an LE1 configuration into LE2. The recommended procedure for
importing an LE1 configuration file is to connect the panel to a computer with LE2 and using the
Transfer Configuration procedure.

Alternatively, the Import option allows the user to select a file generated by the Loop Explorer 1
conversion utility to import into LE2. This import file (in .lx9 format) can be generated in LE1 under File
> Export Loop Explorer Config... > LE2 File Conversion.

WARNING! Using the Import option can result in data voids in the resulting configuration file. The recommended
procedure for importing a configuration file is to use the Transfer Configuration procedure.
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Export Graphix / Guide Data
This tool allows the export of the data for importing into Graphix, Guide or L@ti-View. There are three
save options:

l Graphix / GUIDE
l Graphix / GUIDE (with panel control)
l Graphix / GUIDE (version 2)
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Generate Reports
This feature allows the user to create a .pdf or .csv file that can use to save information about your
network configuration and cause and effects. It also can generate device labels and export Central
Station data.
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Print Network Configuration

This report contains comprehensive information about the entire network configuration, including information
about the Panel, Day / Night Times, Local I/O, Network Interface, SLC Loops, Vision units on the network, and
ActionMessages. This report also details Cause and Effects on the network.

Each network node’s panel is organized by address, from low to high. At the beginning of each Network
Address, the panel name and details are listed in the following format:

Panel FireNET L@titude
Network Address 1
RingMode Common
First Node Address1 0
Last Node Address1 0
Number of Loops 6
Number of Zones 6
Calibration Time 7:00
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The first and last node addresses are used to identify the first and last node of a Class B SLC wired network.

I/O Configuration

Details are provided in the report regarding the Zone Number, Input Action, Delay(s), and Location Text for each
panel I/O for each network node. The following panel I/O are included in the report:

l Programmable Routing Input 1
l Programmable Routing Input 2
l Fire Routing Input
l Trouble Routing Input
l Programmable Input 1
l Programmable Input 2
l Programmable Input 3
l NAC 1
l NAC 2
l NAC 3

l NAC 4
l Programmable 1 Relay Output
l Programmable 2 Relay Output
l Fire Relay Output
l Supervisory Relay Output
l Fire Routing Output 2
l Programmable Routing Output
l Trouble Relay Output
l Trouble Routing Output

Network Configuration

TheNetwork Interface allows a user to select which network events that a panel will respond to, and define the
way in which it will respond. All other panels, aside from the currently-edited panel, will be listed. Click + to
expand the properties of the node and select how the panel will respond to network events. Each panel can have
a unique profile that defines how it will respond to the rest of the nodes and event types on the network.

l Process
l Display
l Log
l Print
l Buzz

When panels are networked together, they share locally occurring events with other nodes on the network. The
following are the panel event types that can be processed.

l Fire
l Emrg
l Aux
l PreAlarm
l Trouble
l Disablement
l Supervisory
l Test
l Status - Reset, Resound, Silence Network Command

When these event types are generated by a node on the network, it will be processed by other networked panels
if that event is selected.
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Loops

Devices connected to each loop are listed, including the Zone Number, Input Action, Delay(s), and Location Text
of each device.

Cause and Effects

TheCause and Effects configuration for each Action, Disable, Test Mode in the configuration file are listed by
name, with two separate tables. One of these tables is for the Cause and one is for the Effect in the relationship.
An example of the format is as follows:

Name: RM408 SMOKE
Type: Action
Operator: OR / Single
Effect: Temporal

Cause Location Text
P01 L3 026.0 ACD-V Multi-Criteria Sensor LEVEL 4RM 408MASTER BEDROOM
P01 L3 027.0 ACD-V Multi-Criteria Sensor LEVEL 4RM 408 FRONT BEDROOM
P01 L3 028.0 ACD-V Multi-Criteria Sensor LEVEL 4RM 408 KITCHEN

Effect Location Text
P01 L3 153.0 ASBL Low Frequency Sounder Base LEVEL 4 SMOKE RM 408MASTER BEDROOM
P01 L3 154.0 ASBL Low Frequency Sounder Base LEVEL 4 SMOKE RM 408 FRONT BEDROOM
P01 L3 156.0 ASBL Low Frequency Sounder Base LEVEL 4 SMOKE RM 408 LIVINGROOM

User Accounts

The user accounts for default levels (1-3) are included and any custom user accounts created. Report details
include each user accounts’ name, account level (1-3), code, and date format. Default accounts will be listed as
follows:

Name 0Default User
Feature Group User Level 2
Code 222222
Date/Time Format MM/DD/YYYY HH:mm:ss

Name 1 Engineer User
Feature Group User Level 3
Code 333333
Date/Time Format MM/DD/YYYY HH:mm:ss

Name 2 KeySwitch User
Feature Group User Level 2
Code 0
Date/Time Format MM/DD/YYYY HH:mm:ss
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Name 3Non Logged User
Feature Group Logged out
Code 0
Date/Time Format MM/DD/YYYY HH:mm:ss

Function Buttons

User accounts with assigned function buttons are included in theAccounts section. Function buttons assigned
to a user account aremarked withYes; otherwise, they aremarked withNo. An example of the format is as
follows:

Name: 1 User Level 2
Session Timeout: 120 seconds
User Function Buttons:

Yes Fire Drill Yes NAC Circuit Disablement No Function Button 3
No Function Button 4 No Function Button 5 No Function Button 6
No Function Button 7 No Function Button 8 No Function Button 9
No Function Button 10 No Function Button 11 No Function Button 12
No Function Button 13 No Function Button 14 No Function Button 15
No Function Button 16 No Function Button 17 No Function Button 18
No Function Button 19 No Function Button 20 No Function Button 21
No Function Button 22 No Function Button 23 No Function Button 24

Network Notes

User notes are included at the end of this report.
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Cause and Effect Only

This report contains only theCause and Effects section of the Network Configuration report. This report
outputs all of the Cause and Effect relationships organized by type (action, disable, test mode) into a printable
PDF format. Each “Cause” and “Effect” in relationship entry is separated into two tables with the Name of the
relationship and type parameters at the top. An example of the format is as follows:

Name: RM408 SMOKE
Type: Action
Operator: OR / Single
Effect: Temporal
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Devices Grouped by Zone

This report contains only the Zones section of the Network Configuration report.
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Devices set for General Alarm

This report lists all devices on the network set for general alarm. It also contains the Flags section from the
Network Configuration report.
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Battery and Cable Length Calculator

This report lists all of the information from the battery and cable length calculator from LE2.

Device Labels

This report lists the labels for all devices configured on the network. This report is only available in .csv format.
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Export CS (Central Station) Data

This option will generate a report of all off premises reporting SIA and CID code data in .csv format for a central
station.
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Once this report is generated, create a new, blank spreadsheet in Excel. Then, clickData > Import to import the
.csv into Excel.

IMPORTANT! Using File > Open in Excel, or double-clicking on the .csv file to open it WILL result in data
translation errors. The import procedure above is the only recommended procedure for viewing the Central Station
Report.
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CONFIGURE TAB
Click the icon to see detailed information about that toolbar option.

Network 51

New Panel Wizard 52

New I/O Module 55

New Device 56

System Manager 57

Quick Config 63

Zone Manager 64

Sensitivity Mgr 65

COMING SOON - Group Manager 67

Loop Manager 68

Cause and Effect 69

Notes 77

Action Messages 78

Templates Mgr 79
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Network
This option displays the entire network view. Refer to GUI Overview for detailed information on the parts
of this window.
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New Panel Wizard
This will open theNew Panel Wizard, which provides the user with a step-by-step walkthrough for
adding a new panel to their configuration. This icon is only visible when the NetworkOverview ( ) is
selected, as shown.

1. Start. Select the desired panel type.

2. Loops. Select the desired number of loops to add to the
network.

Hochiki America Corporation
Loop Explorer 2 User Guide

Version 1.00 |   June 2021 |   MAN-701
Page 52

Configure Tab



3. Panel Text. Enter a panel name (up to 30 characters).
Optionally, enter text (up to 80 characters) to be displayed
on the panel LCD in quiescent mode, such as the
company name and telephone number.

4. Ring Mode. Select the default ringing mode.

5. Review. Review the selected settings.
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6. Finish. Select the action to be done when the wizard
finishes.
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New I/O Module
This will open theNew I/O Modulewindow, which allows the addition of a new module to the
configuration. This icon is only visible when a panel is selected in the network tree.

Select the desiredmodule. Then, select aNode,Address, andQuantity.

NOTE ForMedia Gateway, only theNode field is active and editable.
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New Device
ClickNew Device to add a new device to the configuration. This icon is only visible when a loop is
selected in the network tree.

1. Select the desired device to add to the network configuration.
2. Select the Node, Loop, Address, Zone, and Quantity. 
3. Then, select whether the device is Fitted or Not Fitted.
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System Manager
TheSystem Manager is only available in supported FACPswith predominantly GUI-based input
control. This window contains global settings to configure Function Buttons, Feature Groups, and
User Accounts. These settings are applied to all applicable panels, annunciators, andmodules on
the network tree.

NOTE This feature is not available on legacy panels.
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Function Buttons

These programmable input buttons can be assigned any Input Action and Input Latch setting. All Function
Buttonsmust be assigned a label, color, zone, type, input delay, and feature group. They can also be used in a
cause and effect relationship.

1. To configure a function button, enter a text Label.
2. Select an Input Latch Type from the Type drop-down. Options are Latching, Non-Latching, and Toggle.
3. Select a Color from the drop-down.
4. Click Details. The Input Properties window for this button appears.

a. Select an Input Action. This field describes what type of action the panel should take in response to an activation of the
input.

b. Select the Feature Group(s). This will restrict the action unless the user is logged in as one of the selected User Levels. A
Feature Group is automatically selected when the Input Action is selected, but can be changed.

c. Check the Output Delay Bypass box if activation of this circuit should immediately activate its associated outputs, even if
those outputs have configured delays.

d. Select a Function Button Color from the drop-down. If a color had already been selected in the System Manager
window, it will be reflected here. A new color can be chosen if desired.

e. Input Action Message is automatically set based on the selected Input Action. If desired, a custom Input Action
Message can be entered.

f. Set the Input Delay in seconds, up to 180 seconds. This setting delays the panel's response to an activation. No panel
response will occur if the input state is restored to normal before time period expires. A non-latching input will not activate
if restored before the time period expires.

g. Set the Input Latch to Latching, Non-latching, or Toggle.
h. Each input circuit is Normally Open, but Closed upon activation. Selecting Input Invert will set the circuit to be Normally

Closed, but Open upon activation.
i. Set the Location Text, up to 80 characters. This text is displayed when the circuit is activated.
j. Set the desired Map to Zone number for the circuit. Allowable values depend on the panel.
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Feature Group

Feature Groups permit and restrict access to variousGUI features. The Feature Group can bemodified using
theDetails button. A maximumof 27 groups are permitted.

l To edit an existing Feature Group, click Details. The configuration window will display, allowing the modification of that
feature group.

l To create a new feature group, click Add New at the right. This will also display the configuration window. Enter the
desired information for the new feature group.

NOTE Feature Groupswith a Group number of 4 or more can be deleted. Users are not permitted to delete default
user accounts (Group Numbers 0 - 3).
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This window allows the selection ofUser Function Buttons andUser Menu Option Buttons for the selected
Feature Group. Selecting a box in theUser Menu Option Buttons orUser Function Buttons pane will add
or remove themenu button for the Feature Group.

l The Session Timeout countdown (in seconds) is the countdown timer for user logout due to inactivity. Range between 0 -
255.

l Group Name (20 characters) can also be configured. Default Group Names (Groups 0 - 3) cannot be changed.

User Menu Option Buttons

Feature Description Selected by
Default for...

Delay Control This option allows (checked) or prevents (unchecked) a user to set delay
timers in their configuration when using the panel GUI.

Group Number 1
(User Level 2) and
higher

Reset System
This option will add (checked) or remove (unchecked) the Reset button from
theGUI. If unchecked, users will be prevented from clearing active event
conditions (fire, trouble, supervisory, etc) locally or across the network.

Group Number 1
(User Level 2) and
higher

Silence Alarms
This option will add (checked) or remove (unchecked) theSilence Alarms
button from theGUI. If unchecked, users will not be able to silence active
NACs on the system locally or across the network.

Group Number 2
(User Level 3) and
higher

Buzzer Silence
This option will add (checked) or remove (unchecked) theBuzzer Silence
button from theGUI. If unchecked, users will not be able to silence active
buzzers locally or across the network.

All User Groups

User Options
This option will add (checked) or remove (unchecked) theUser Options
menu, and/or add or remove individual items within the User Options menu,
including, but not limited to, Panel Tests, View Event Log, and Disablements.

All User Groups
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Feature Description Selected by
Default for...

Engineer Options

This option will add (checked) or remove (unchecked) theEngineer Options
menu, and/or add or remove individual items within the Engineer Options
menu, including, but not limited to, Edit Configuration, Autolearn, and Engineer
Disablements.

Group Number 2
(User Level 3) and
higher

Fire Events
Fault Events
Disablement Events
Other Events
Zone in Test Events

This option will add (checked) or remove (unchecked) the associated event
tab from theGUI. Zone in Test Events are displayed in theOther Events
tab.

All User Groups

User Controls This option will add (checked) or remove (unchecked) the ability for the user to
login to another account or logout until the session timeout expires. All User Groups.
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User Accounts

Each panel installer can be assigned a unique user account, which can then be assigned to a Feature Group.
User Accounts can bemodified using the configuration window in theDetails button. A maximumof 63 user
accounts can be created.

1. Select a User Number from the drop-down box. Accounts with a User Number of 4 and higher can be deleted. Users are
not permitted to delete default user accounts with a User Numberbetween 0 – 2.

2. Enter a User Name. User Names have a 20 character limit. Default User Names cannot be modified.
3. Enter a User Passcode. This passcode must be either 5 or 6 digits long. Only numbers are permitted.
4. Select a User Group level from the drop-down box.
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Quick Config

Quick Config displays a table that shows every SLC device on the loop and allows the zone
number and location text of each SLC device shown to be edited.
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Zone Manager
The Zone Manager is a tool used for quickly viewing all panel and loop devicesmapped to selected
zones, and for configuring them to particular zones. The list on the left shows all zones. The highlighted
icons contain devices, where the shaded ones do not.

View all of the SLC devices, or panel inputs and outputs that are assigned to that zone by clicking on that zone in
the Zone List. Drag-and-drop SLC devices and panel I/O to a selected zones. If the AlarmVerification feature is
enabled in the network settings, it can be enabled or disabled from ZoneManager on a per zone basis.

NOTE There are some restrictions on legacy panels.

1. Select a Panel to view contents of the selected zone.
2. Select one or more items - to select multiple items hold Ctrl or Shift and select the desired items.
3. Drag-and-drop desired items onto a new zone. This will remove the icon from the view on the right, as it has been moved

to the new zone.
4. To make changes to the zone name or enable alarm verification, double-click the desired Zone in the left pane. A Zone

detail window will appear.
5. To enable Alarm Verification operation, select the Alarm Verification Enabled check box for that zone.
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Sensitivity Mgr
Sensitivity Mgr is a configuration tool for making global changes to individual or multiple sensors of
the same type on the network without modifying each sensor separately.

To set the sensitivity of an individual or multiple devices,

1. Select the desired sensor type from the Set Sensitivity For drop-down list. All available device types connected on the
loop are shown in the list. Once a device type is selected, the sensitivity editor is displayed along with all applicable
modes. Configure sensitivity as desired. Polling LED Flash and Pre Alarm mode may also be set at the bottom of this
window.

2. The entire network tree for the selected sensor device type is displayed on the left. Other devices that may be on the loop
are not shown. The network tree view may be restricted by the panel using the View Items From Selection drop-down.
Check the boxes for the desired devices to apply the sensor settings.

3. Enter the desired selections (Day and Night Sensitivity, Smoke Density, etc.).
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4. Click Set Sensitivity. A confirmation window will appear. Changes will be made on all selected sensors.
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COMING SOON - Group Manager
TheGroup Manager allows user to add zones, inputs, and outputs into one or more groups. These
Input andOutput Groups can be used in a cause and effect relationship. The groups are displayed in
the tree andmust be given a name and type. Any input or output shown in the network treemay be
placed in either an input or output group. Anything placed in the group is displayed in the center pane.

Up to 5000 total groupsmay be configured and eachGroup Name can be up to 20 characters long.
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Loop Manager
The Loop Manager can be used to configure output SLC devices to become active for event types
options listed. This tool can also be used to configure Polling LED andOutput Delay Bypass for Input
SLC devices.
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Cause and Effect
A Cause and Effect relationship is a custom program created to link any input or group of inputs on the
system, to any output or group of outputs.

Relationships can be generated between inputs and outputs using the Cause and Effect wizard located in the
Configure tab. These relationships are based on an action and resulting reaction. TheACTION is one or more
inputs referred to as theCause. The resultingREACTION is the activation of one or more outputs referred to as
theEffect.

LE2 currently supports three types of cause and effect relationships:
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Action
Creates an action output in response to an input activation. One example of an Action C&E is
a relay that follows the state of an input. A common applicationmight be relays for elevator
recall, door release functions, or damper control.

Disable Creates an input (with an Action of Disablement) that disables outputs or zones on one or
more panels.

Test
Mode Creates an input (with an Action of Test) that puts a zone or zones into Test Mode.

Each relationship type has predetermined input action types that must be established before attempting to use
the input in the cause and effect wizard. If a user attempts tomake a relationship without configuring the input, no
selection will be allowed.

Use Case

These relationships can be useful when using input actions that generally have no reaction, such as
“transparent” inputs. They can also be used to create evacuation events that are generated by specific inputs. It
is recommended that default settings are removed fromEffect outputs to prevent activations outside the cause
and effect relationship.

Each Cause and Effect Relationship is organized by name in an expandable list. Itemswithin the tree can be
copied and deleted.

l The C&E Entries tab displays information related to the selected C&E(s).
l The Used Items tab displays all inputs and outputs used in Cause and Effects.
l The Unused Items tab displays all unused inputs and outputs.
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Cause and Effect Wizard

Each type of relationship can be configured using a wizard for the specific type. Based on panel type, permitted
valuesmay vary. For non-legacy panels, a maximumof 5000 entries are allowed in the Cause & Effect tree and
amaximumof 50,000 inputs and outputsmay be assigned.

Common features for each wizard include:

1. Each tab displays a variable list of I/O items available for Cause and Effects. When an item is selected, that tab will be
highlighted in green.

2. Check All or Uncheck All buttons to select or deselect all inputs listed in the selected input category.
3. The lists of I/O devices display detailed information for each. The list can be sorted by column, and a <Ctrl+click> will

allow multi-column sorting.
4. All C&E entries must be named at the end of the wizard

Action Operator

Action operator items define the input conditions that will generate the effect.
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AND/ALL

TheAND/ALL operator allowsmultiple inputs to trigger the cause.When this
operator is selected, two or more inputs are required to trigger the effect. If
three inputs are selected for theCause, all inputsmust be active before the
Effectwill be triggered.

OR/Single
TheOR/Single operator allows a single input to trigger the cause. If a group of
inputs is selected for theCause, a single activation of an input within the group
will trigger theEffect.

Coincidence / Any 2 TheCoincidence / Any 2 operator allows any combination of pairs in a group
of 2 or more inputs to activate theCause.

Coincidence by Zone

TheCoincidence by Zone operator allows any combination of pairs in a
group of 2 or more inputs in a single zone to activate theCause. This operator
also allows the user to disallow the use of any pull station as an input. This
operation is only available for Action relationship types.

Output Type

These are the output patterns that supported devices can generate. Not all devices support all patterns. These
patterns override assigned output patterns configured in the network tree.

l Temporal
l Continuous
l March

Output Delay Override

Checking this option will override any previously delayed outputs and immediately activate them.

Action

The Action relationship type can be used with any input or group of inputs. The relationship ismade up of a
Cause of one or more inputs and the effect of one or more outputs.

TheCause flowswith the following logic:

Cause: Input categoryà Input 1àAction Parameter SelectionàStart DelayàNext

Each input must be selected in one or more categories before theywill be entered as aCause variable. Inputs
are categorized in the Cause and Effect ActionWizard by the following:

l Input Groups
l Timers
l Function Buttons
l Loop Inputs
l I/O Channel Inputs
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l Fire Zone Inputs
l Panel Inputs

All selected inputsmust be assigned an Action operator that defines the input conditions that will generate the
effect. TheEffect flowswith the following logic:

Effect: Output categoryàOutput 1àOutput Type selectionàDurationàNext

EachOutput must be selected in one or more categories before theywill be entered as anEffect variable.
Outputs are categorized in the Cause and Effect ActionWizard by the following:

l Output Groups
l Timers
l Loop Outputs
l I/O Channel Outputs
l Zone Outputs
l Panel Outputs

All selected outputsmust be assigned anOutput Type that defines the pattern that will be used when the effect
activates.

Start Delay

Cause inputsmay be optionally assigned a Start Delay timer. The start delay timer delays the response input(s)
triggers in theCause for specified time inminutes and/or seconds.

Disable

TheDisable relationship type can be used to prevent a response from desired I/O. The Causemust be an input
or group of inputs configured with the Input Action = Disablement. Inputs are categorized in the Cause and Effect
DisablementWizard by the following:

l Loop Inputs
l I/O Channel Inputs
l Panel Inputs
l Function Buttons

The Effect can be applied to one or more Inputs andOutputs in the following categories:

l Zone
l Local I/O
l Output Groups
l Input Groups
l Inputs
l Outputs
l I/O Inputs
l I/O Channel Output
l Loops
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Disabled I/O can be re-enabled when the cause is reset and the Enable action is taken from the disablements
screen in the panel GUI.

Test Mode

The Test Mode relationship type can be used to force a zone or group of outputs into a special test mode that will
force all detectors to become non-latching. TheCausemust be an input or group of inputs configured with the
Input Action = Test Mode. Inputs are categorized in the Cause and Effect Wizard by the following:

l Loop Inputs
l I/O Channel Inputs
l Panel Inputs
l Function Buttons

The Effect can be applied to one or more Zones andOutput Groups.

Test Type

NAC outputsmust be set to Silent or Audible under Test Type to configure if Effect sounders should activate
hornswhen the cause is triggered.

Cause & Effect Wizard Walkthrough
1. To create a Cause & Effect, select the icon for the type of C&E in the bottom-right pane. The Cause & Effect Wizard will

open. All available SLC devices are displayed in the tabs shown. Each device is listed numerically by address and loop
number. These devices can be sorted by column. Multi-column sorting is available by holding Ctrl while clicking the
desired columns.
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2. Click the checkbox next to each desired item to make a CAUSE selection.
3. Move through the tabs to make all desired CAUSE selections. Tabs with selected devices will be green. To select all

inputs in the active tab, click Check All. To clear the current selections, click Uncheck All.

4. Select the desired Action Operator. Refer to Action Operators for detailed information on each selection.
5. If desired, set a Delay period in Minutes and Seconds. The start delay timer delays the response input(s) triggers in the

CAUSE for specified time in minutes and/or seconds.
6. Once all input selections have been made, click Next. The Effect window will appear.

7. Select the desired outputs from each tab.
8. Choose whether the Output Type should be Temporal, Continuous, or March. Refer to Output Types for detailed

information about these selections.
9. If desired, select the Output delay override. Checking this option will override any previously delayed outputs and

immediately activate them.
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10. Set the desired Duration of the output. If no duration is set, it will remain active until the input switch is restored AND the
panel is reset.

11. Click Next. The Finish window will appear.

12. Enter a name for the Cause & Effect. Click Finished.
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Notes
TheNotes tool offers a notepad for users to store information or notes about their network file. All notes
are left justified. Only plaintext is allowed.When pasting text from a another text editor in Notes, minimal
formatting is retained. The tool will keep numbered and bulleted list items indented with space padding.
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Action Messages
When configured, the control unit will display custom or default text
as detailed by the user. This enables the user to display custom
Action Messages that replace the default event actionmessage.
Up to 9 custommessagesmay be stored.

1. To define new action messages, click Action Message in the toolbar. The Input
Action Messages window will appear.

2. Select any of the User Message entries and enter the new, desired action message.
3. Click OK.

To use a custom actionmessage, edit the properties of any input and use the Input Action Message drop-
down list. The actionmessages can bemodified in these windows, by clicking the icon next to the Input Action
Message field.
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Templates Mgr
IMPORTANT! This feature is not available in all configurations.

The Templates Manager allows users to create customMedia GatewayOff-Premises reporting code
tables that can be imported or exported to theMedia Gateway. The wizard assists with template
creation. Depending on the user permissions and configuration, different optionsmay be permitted in
the Table Editor. For more information, contact Technical Support.

For full details and technical information, refer to theMedia Gateway Panel Module (S788) Functionality and
Configuration Guide (MAN-1483).
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TOOLS TAB
Click the icon to see detailed information about that toolbar option.

Dial Modem 81

Transfer Configuration 82

Transfer Quiescent Screen 85

XML Import 87

XML Export 88

Panel Event Log 89

Loop Analog Values 90

Update Panel Firmware 91

Virtual Panel 93

Monitor Mode 94

Battery Calculator 95

Edit Preferences 96

License 99

Loopback Test 100
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Dial Modem
TheDial Modem feature allows users to interface to a serial dialer modem. This can be used to test call
a fire alarm system. A modem is required for this functionality.

NOTE This feature is only supported on legacy panels.

1. Before using this functionality, the Dialer Modem COM port must be set in Edit Preferences.
2. Add Dialer to the network.
3. Click On and enter the phone number of the panel(s) to call.
4. Once a connection is made, the user will be able to import the event log and analog values from the connected panel.
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Transfer Configuration
The Transfer Configuration tool allows users to either import or export a configuration file or set the
time on the connected control unit.

NOTE If the Transfer Configuration icon is disabled, check the LE2 license.

A transport method compatible with the hardwaremust be used in order to transfer configurations between LE2
and a control unit.

ClickConnect to Panel to auto-detect the connected Fire AlarmSystem(s).

Panels in the LE2 configuration are displayed on the left side. The panel found on the network will be displayed,
along with the latest modification date, and panel type. The date in theModified column is the last date a
configuration was transferred to that panel.

ClickTo PC or To Panel to control the direction of the transfer. TheDirection column in the center of the
window will display an arrow to indicate the direction of the transfer.

There are two options for transferring theMedia GatewayCustomTable. Include MG2 Custom Table
Transfer will include the custom table with the configuration.MG2 Custom Table Transfer ONLY transfers
ONLY the custom table and will not update the configuration of the selected panel.

Use theSet Time button to use LE2 to set the date and time on the selected panel.
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USB Transfer

TheUSB transfer is dependent on the Fire Alarm control unit hardware; the USB port must be identified before
attempting to transfer a configuration using LE2.

USB-A Port Configuration

Use the XML Import or XML Export features to perform a transfer with a USB drive.

Transfer Configuration from a Control Unit to LE2 using a USB-A Flash Drive

Follow the procedures in XML Import to import a configuration using a flash drive.

Transfer Configuration from LE2 to a Control Unit using a USB-A Flash Drive

1. Obtain a USB-A flash drive containing the desired LE2 configuration file. For information on getting the configuration file
onto a flash drive, see XML Export.

2. On the panel, log into a User Account with User Access Level 3. The default user account with this permission is the
Engineer, which has a default passcode of 333333.

3. Remove anything attached to the USB drive (keychains, etc) to prevent stress damage to the port. A loose connection will
cause a read error.

4. Insert the flash drive into the appropriate port.
5. On supported control units, the panel will display a list of files that may be overwritten or imported. This may take up to 5

seconds. If the control unit does not display file list, ensure that the panel is logged into a User Account with User Access
Level 3. On the panel, select Engineer Options > Edit Configuration > Import/Export Configuration.

6. Select the desired file and select Import.
7. Confirm Import operation when prompted.

USB Transfer using a Cable

Determine the USB port on the computer and obtain an appropriate cable with amale USB connection. The
exact cable needed depends on the USB ports available on the panel and computer.

Import to LE2

1. If a configuration has not been defined, log into a User Account with User Access Level 3. The default user account with
this permission is the Engineer, which has a default passcode of 333333.

2. Perform an Autolearn.
3. Connect the USB cable from the PC to the control unit.
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4. In the Transfer Configuration window, select Connect to Panel and To PC for the direction of transfer.
5. Click Transfer to PC.

Export to Control Unit

A configuration file may be exported from a previously saved configuration file or fromworking network file in
LE2.

1. Connect the cable from the computer to the USB-B port on the control unit.
2. Click Connect to Panel > To Panel for the direction of transfer.
3. Click Transfer to Panel.
4. Wait for the configuration transfer to complete. A window will display requesting to return to the network tree.
5. The USB Cable may be removed from the control unit.

Serial Transfer

On supported panels, users can use a serial programming cable to transfer configuration files between LE2 and
the Fire AlarmSystem .

1. Using a serial programming cable (described in detail in Getting Started), plug the serial connector into an open COM
port on the computer. Note the port number that corresponds to this COM port. This port can be selected in Edit
Preferences. Use the Windows Device Manager to determin which COM Porrt is associated with the Serial Adapter.

2. Connect the other end of the serial cable into the 10-pin port (labeled PC).
3. Click Transfer Configuration from the Tools tab and click Connect to Panel.
4. On some legacy panels, a password may be required. Enter the appropriate password.
5. LE2 will automatically detect connected units with an icon. Select the desired panel.
6. Select the direction of the transfer.
7. Click Transfer to ______ and wait for the transfer to complete. A window will display requesting to return to the network

tree.
8. Repeat this process if other panels on the network require configuration.
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Transfer Quiescent Screen
On deviceswith an LCD screen, a customGUI Screen or logomay be transferred from LE2. This
screen will be displayed on the unit when the panel is in normal standby. This tool provides storage and
management for multiple images.

To add new images, clickQuiescent Screen Maintenance. ClickAdd New to search for an add new images to
the list.

Image filesmust be .png, cannot bemore than 780 pixels x 283 pixels, and not over 2.6MB in size.

Existing image detailsmay be edited when the desired image row is double-clicked. Each imagemay be given a
Name and Description that will be displayed in the Quiescent ScreenMaintenance table. A thumbnail will be
displayed for each image.
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1. To select one of these images for your quiescent screen, go to the Network view (File > Network).
2. Double-click the desired panel to open the Edit Propertieswindows.
3. Select the Misc. tab.

4. Use the Select New Image drop-down to choose which image to use for the quiescent screen and click Save.
5. Repeat this process for each panel on the network. The image will be updated at the time of the next configuration

update.
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XML Import
This option allows users to import a configuration file.

NOTE Not available on Legacy panels.

1. Click XML Import.
2. Navigate to and select the desired configuration file to import and click Open.
3. Click To PC.
4. Click Transfer to PC.
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XML Export
This option allows users to export a configuration file. Click theXML Export button on the Tools tab to
name and save the .xml file.

NOTE Not available on Legacy panels.

A USB A flash drive with at least 1MB of available space is required for thismethod of configuration transport. A
user may also choose to save the file locally on their PC for future use.

1. With the USB drive inserted, click XML Export.
2. Select the panels to include in the transfer.
3. Click Select File and navigate to the USB drive. The file must be placed directly on the drive, NOT in a folder. Saving the

file in a folder will prevent the panel from locating it.
4. Enter the desired file name and click Save.
5. Click Export to initiate the export process. A notification will appear when the transfer is complete.
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Panel Event Log
The Event log screen allows the option of uploading the event log from a given panel from its stored
memory, and to view it from a computer. The events are stored in order of priority and occurrence.
When the event log is full, the oldest and lowest priority event will be dropped as new events occur.

NOTE The number of events that can be stored in the Panel Event Log is panel-dependent.

1. Connect the control unit to the computer using the appropriate cable.
2. Click Connect to Panel and select the desired panel from the drop-down box on the Event Log tab.
3. Click Fetch to obtain the log from the panel and display the Event Log window.
4. Click Save to save the event log as a .csv, which can be opened in a spreadsheet.
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Loop Analog Values
Sensors (detectors) on a SLC loop have Analog Valueswhich represent current value (clean air), last
calibrated zero point, and last calibrated fire point. These Analog Values relate to the health of the
sensor. These values can be retrieved using theGet Loop Analog Valueswindow.

1. For Legacy FACPs, connect a serial programming cable with an adapter to an available port on the computer. Set the
Serial COMM port in Edit Preferences. For current panels, use a compatible cable to connect the computer to the control
unit's USB-B port.

2. Choose a panel from the drop-down list box.
3. Click Connect to Panel. Enter a password if prompted (1111 or 4444).
4. Select a Loop on the panel from the drop-down box.
5. Click Fetch to retrieve the values of all sensors on the chosen Loop(s).
6. Click and select a device from the list to show the reading and the calculated percentage of the Health.
7. Click Save to save the Analog Values as a .csv file, which can be opened in a spreadsheet.

Hochiki America Corporation
Loop Explorer 2 User Guide

Version 1.00 |   June 2021 |   MAN-701
Page 90

Tools Tab



Update Panel Firmware
This tool allows the user to update the panel firmware on supported control units. Before attempting to
update the control unit, place the firmware file in a location on the local hard drive. The firmware is
updated from a firmware file saved on the PC that is exported via LE2. It is important the control unit
maintain AC Power during the entire update.

FireNET / FireNET + / Elite / Elite RS

Before beginning, obtain serial programming cable and a Serial to PC adapter detailed in Getting Started. This
hardware is required to communicate with control units that use serial ports.

1. Connect the serial programming cable with adapter to available port on your PC.
2. Set the serial comm port in Edit Preferences. Use the computer Device Manager to determine which the comm port is in

use by the serial adapter.
3. Connect the serial cable to the appropriate 10-pin port. On applicable units this is J5.
4. Install a short circuit jumper link to appropriate link. On applicable units this is JP1.
5. Set the programming switch to PC mode on applicable control units.
6. Click Update Panel Firmware. The Flash Upgrade window will appear.

7. Select the desired firmware file using the file navigator inside the window.
8. Select the Comm Port and Baud Rate.
9. Press and hold the front panel Fire Drill and Enter buttons. While holding down these buttons, press and release the

RESET switch (SW2 on applicable units).
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NOTE To select the higher baud rate, hold the front panel Reset andEnter buttons of the front of the panel. While
holding down these buttons, press and release theRESET switch.

10. If successful, the panel display will be blank and front panel indicators may be illuminated.
11. Release the Fire Drill and Enter buttons of the front of the panel.
12. Select the comm port and baud rate. Click the Start button. If an error occurs, select the other baud rate option.
13. There will be a loading bar in the window giving progress updates.
14. A pop-up window will be displayed when the transfer is complete. The panel should start initializing automatically. If it

doesn't, press the RESET switch (SW2 on appliable units).
15. Remove the short circuit jumper link (JP1 on applicable units).
16. Autolearn the panel.
17. Load the site configuration file into the panel.
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Virtual Panel

This tool provides remote access to the fire alarm system’sGUI and other controls from a computer.
This tool will emulate physical buttons on applicable control units.

NOTE Virtual Panel is only supported on legacy panels.

FireNET / FireNET + / Elite / Elite RS
1. Connect a serial programming cable with adapter to an available port on the computer. In Edit Preferences, set the serial

COMM port in use.
2. Click Connect to Panel.
3. Enter a password; either 1111 or 4444.
4. Once logged in, click Start to begin panel emulation and remote access.
5. Once logged in, the GUI can be navigated as if physically at the panel. Any events on the system will activate the

emulated indicator LEDs.

NOTE To connect to other nodes on the network, repeat the login process and select the desired node in the
Address drop-down.
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Monitor Mode
TheMonitor Mode tool themonitoring and saving of ASCII text output from the control panel. For
example, it can be used to observe real-time event data printed by the control panel's printer on the
computer monitor.

NOTE This feature is only available on legacy panels.

This tool requires a serial programming cable and a Serial to PC adapter, as detailed in Getting Started.

1. Set the Serial COMM port and Baud Rate (19200) in Edit Preferences. To determine which COMM port is connected to
the serial adapter, consult the device manager of the computer running LE2. Click Save.

2. Click Monitor Mode.
3. Click Start to begin capturing data.
4. Use the control unit to generate desired printer events to capture, such as Fire Drill.
5. Click Audit Stamp to print a date and time for captured text.

6. Click Stop to end data capture.
7. Save or clear data as desired. Saved data is placed in a .txt file in the same format as the captured text in the window.

Unprintable characters print symbols.
8. Click Close to exit. All unsaved data will be lost.
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Battery Calculator
The battery calculator assists in determining the required backup battery capacity and themaximum
cable length for the SLC and Panel NAC circuits. The tool uses a combination of user data and known
data tomake the calculations to produce a report. All formulas used in the calculator are clearly stated
for local authority transparency.

This tool uses known data for the control unit, loop devices, and peripheral cards, as part of the battery and cable
length calculations. Other variablesmust be input by the user to complete calculations for the report . These
unknown variables include Total Expected Current.

The report provides aMaximumSLC cable length, NAC cable length, and theminimumbattery capacity
requirement and all variables, 24V power supply loads, and calculations that produced these results. The results
of this report can be saved as a PDF or as a spreadsheet file (*.csv).

If there is a network of panels, the desired panel must first be selected before using the calculator.The calculator
information is stored for each panel unless another configuration is imported from the panel. The import will
erase the contents of the battery calculator.
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Edit Preferences
This tool can be used to set preferences for Loop Explorer 2, such as Auto Save, Save location, and
Language. It can also be used to set preferences for zones, project trees, window prompts, and display
items. Some critical items are set in this window such as the selection of the Serial CommPort and the
Updates page.

General Tab

TheGeneral Tab can be used to set commports, the Default Project Folder (where projects will be saved), Auto
Save options, and language. The serialComm Portmust be set before using some features in LE2, such as
configuration transfer on control units that use serial communications. Select an appropriateBaud Rate.
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Display Options

TheDisplayOptions Tab can be used to set preferred defaults, such as zones, time zone, temperature unit,
display settings, and reset window sizes. All changesmade in this window will be applied across all projects in
LE2.
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Updates Tab

TheUpdates Tab can be used to check for updates to LE2. An internet connection is required. ClickCheck
Now to determine if any updates are available.

Also in the Updates Tab, the Virtual Resource password can be updated or changed if it has expired. Click
Change to open a window that will connect to the passwordmaintenance page to the Virtual Resource website.

An internet connection is required to change the VR password. Once the password is changed, enter the new
password in the License window.If an incorrect password is entered 10 times, the LE2 account will be locked.
Contact Tech Support to unlock the account.
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License
The license window holds the current username and password and the expiration date for the user
license. The current user can be changed in this window by entering alternate credentials.

Each License can be set for a duration of 7 days - 6months for each user, depending on the the admin setup.
This limitation exists to prevent unauthorized access to a client’s system. This expiration date is displayed on the
Licensewindow. A warning will be given several days before the license expires. Once the license has expired,
LE2 can still be used, but some featureswill be limited, such as panel programming andGuide export files.

NOTE An internet connection is required to access the License window, renew a license, or update an expired
license.
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Loopback Test
The Loopback Test tool requires the use of a serial loopback adapter. This tool allows users to test the
connectivity of the transmit and receiver of a serial cable. When the connection is working, any data
entered in the transfer boxwill be displayed in the receiver box.
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HELP TAB
Click the icon to see detailed information about that toolbar option.

View Application Errors 102

View Communication Logs 103

Company Name 104

About 105
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View Application Errors
This is a diagnostic tool that serves as an application error log. It stores details on any error codes
encountered in LE2.When a process fails, it is listed in this window, with a timestamp and description.
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View Communication Logs
This is a diagnostic tool that monitors the communication between LE2 and connected units. The data
being sent/received is logged here. This featuremust be activated inEdit Preferences > Display
Options > Record Panel Programming Audit Data (checkbox) before the data will be logged.
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Company Name 

This will open the website for Hochiki or VES, depending on the configuration and selected database.
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About
This window displays information about the Software Version, Database Information, and Release
Type.
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PANEL CONFIGURATION
Panel Configuration will depend on the site, customer, and local authority requirements. When new panels are
added, LE2 will build a baseline network tree based on the panel type. Double-click the desired network panel to
access the settings.

Panels 107

FireNET L@titude, VES L@titude, Compas 107

Elite, Elite RS, eLAN RS, FireNET, FireNET+, FireNET LCD Network Annunciator 123

FireNET Vision, L@titude Vision, CompasVision 133

Panel I/O Configuration 137

Inputs 137

Outputs 137

Function Button Configuration 139
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Panels
FireNET L@titude, VES L@titude, Compas

Panel Data Tab
NAME
Text Box, up to 30 characters allowed, including special
characters.

This is the name of the selected panel.

PANEL ADDRESS
Drop-down List. Allowed values are 1-64.

This is the node number of the panel on amulti-panel
network. The first panel added to the configuration will be
assigned an address of 01. Subsequent panels added will be
assigned the next available address number, or a specific
address can be selected from the drop-down box.

NOTE If a panel address is changed in LE2, the
physical address must be changed as well.

NUMBER OF ZONE LED INDICATORS ON PANEL
Drop-down List. Allowed values are 0, 48, 96, and 144.

This sets the number of Zone LEDs available on the panel.

ZONE OF FIRST LED INDICATOR
Drop-down List. Allowed values are panel-dependent.

This sets the number of the first LED on the zone
LED board.

1ST IN ALARM FLASH
Radio Button

Select this option to direct the first LED to activate to flash.

1ST IN ALARM LIT CONSTANTLY
Radio Button

Select this option to direct the first LED to activate to light
constantly.
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PANEL TEXT
Text box. Up to 80 characters, including special characters.

This will provide site location details that will be displayed on
theGUI of all panels on the network when events are
generated on the panel.

INTRINSICALLY SAFE DEVICES -Apollo Protocol
Only
Check Box.

This sets the characteristics of the detection circuit to
enable the correct monitoring of the circuit. Selecting this
option will reduce the number of LEDs active on each loop
from 5 to 2, which will reduce the current draw.

GLOBAL PATTERN
Drop-Down List. Allowed values areContinuous (high
steady state),March (high and low for even intervals), and
Temporal (synchronized on a system basis, three even
on/off cycles followed by off period).

This will set the pattern that will be assigned to a NAC
circuit output pattern.

BACKLIGHT CONTROL
Drop-Down List. Allowed values areAutomatic Dim and
Fixed Brightness.

This sets the backlight control of the LCD display.

BUTTON SOUND
Drop-Down List. Allowed values areAudible andSilent.

This setting will determine whether touching the GUI will
produce a sound.
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ANY 2 DEVICES TO BYPASS DELAYS - DEF RING
MODE OUTPUTS ONLY
Check Box.

When delays are present on SLC or panel outputs, an
activation of two or more points will remove the delays and
cause the outputs to activate immediately.

NOTE All delayed outputsmust be configured for general
alarm for this feature to take effect.

RESOUND FOR FIRE IN SAME ZONE
Check Box.

Check this box to force the control unit to re-activate
silenced NACs if a second point activates within the same
zone as the first point.

RESOUND FOR FIRE IN OTHER ZONE
Check Box.

Check this box to force the control unit to re-activate
silenced NACs if a second point activates in a different zone
from the first point.

DEFAULT SYNC PROTOCOL
A |  B
Drop-Down List. Allowed values areGentex, Amseco,
Wheelock, andSystem Sensor.

This sets the strobe protocols being used. Only two
protocols may be used at a given time.
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GENERAL ALARM
Radio Button. Allowed values areCommon (The panel will
activate all notification appliances zones when any General
alarm activation occurs.) and Zonal (The panel will activate
a general alarm for outputs ONLY in the same zone as the
activation point. If a subsequent point of activation is in
another zone, all notification appliances in that zone will be
activated.)

This sets how the panel will respond to a single general
alarm activation.

GLOBAL DELAYS
Up / Down Arrows. Allowed values are 0-10, in 0.5minute
increments.

This sets an output delay for the set number of minutes if the
Ignore Global Delay check box is unselected.
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PANEL NACs
NAC 1 AND 2 |    NAC 3 AND 4
Radio Button. Allowed values areOne Class A and Two
Class B (default).

This sets the class configuration for NAC pairs.

CIRCUIT CURRENT LIMIT
Up / Down Arrows. Allowed range is 0.5 - 2.5A.

This sets the current limit on the NAC circuit. All panel
NACs may be restricted to overcurrent at a defined upper
threshold. If this limit is exceeded while the NAC is active,
the FACP will shut down the NAC and post a Trouble. This
setting will affect battery load calculations.

CIRCUIT TIMEOUT
Up / Down Arrows. Allowed range is 50-250ms.

This sets the amount of time the NAC will stay active once it
reaches the circuit limit.
SUB ADDRESSES

This displays the number of sub addresses in use and the
number available. The number of subaddresses available
will change, depending on the number of loops on the
network.

The usage bar changes as subpoints are added or deleted on
the loop. Total devices is also shown.
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Times Tab

This tab allows the configuration of set timed features common to panel operations.

DAY - START TIME |     DAY - END TIME
Up / Down Arrows. Any time of day (24 hour time
format) is allowed, incremented inminutes.

The start and end times are used to define the Day
and Night mode of the panel. Between the hours set
for Start and End Time, the detector's Day sensitivity
is used. The Night sensitivity is used during all other
hours.

SOUNDER TIME-OUT
Drop-Down List. The panel default is 0, which
disables this feature. Allowed values are 5 to 60
minutes, in 5minute increments.

This programs the NAC circuits to automatically
silence after a period of time.
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AC FAILURE REPORT DELAY
Up / Down Arrows. Allowed values are 0-240
minutes. The default is 60minutes.

This configures the panel to delay ground trouble
annunciation by time period. All normal panel trouble
responses andMedia Gateway signaling
(configuration-dependent) will occur after official
trouble annunciation at the panel.

CALIBRATE SENSORS DAILY
Up / Down Arrows. Any time of day (24 hour time
format) is allowed, incremented inminutes.

This sets time each daywhen the sensors will
perform their calibration routine. Calibration occurs
once per day and should be set to a time when
building environmental conditions aremost stable.
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ALARM VERIFICATION
Up / Down Arrows. Allowed values are between 5-
55 seconds, in 5 second increments.

This sets the timing delay for the verification period.

NOTE This field will be disabled untilAlarm
Verification is set in the NetworkSettings.

TIME ZONE
Drop-Down List. Allowed values include all global
time zones.

This sets the appropriate time zone. The default
shown here will match the time zone set inEdit
Preferences.
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Network Interface Tab

The network interface tab is available in the panel settingsmanager of networked panels. This tab is disabled for
panels on a single node network.

TheNetwork Interface tab allows a user to select which network events that a panel will respond to, and define
the way in which it will respond. All other panels, aside from the currently-edited panel, will be listed. Click + to
expand the properties of the node and select how the panel will respond to network events. Each panel can have
a unique profile that defines how it will respond to the rest of the nodes and event types on the network.

Action Description

Process

This instructs the node receiving a network event to behave exactly as it would if it were a local node event. For
example, in the even tof, the panel would be expected to activate the NAC outputs and fire relays. Selecting the
Process option ensures that the panel does this from network fire events. If the process option is not selected, the
panel would not process the event as a local event and would not activate the NAC outputs or fire relays when a
fire event is received from the network.

Display This option instructs the node receiving the network event to display the event on the LCD display exactly as it
would if it were a local node event.

Log
This gives the option to store the network event in the local node event log. For example if a panel is designated as
amaster panel, it may be required that the panel logs all events on the network, whereas other panels log only
their own events. Each node can store up to 500 events in the event log.
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Action Description

Print
This gives the option to print the network event. The node will print local events and network events assigned to it.
It is possible that amaster panel can be required to print all events (both local and network wide), while other
panels print only local events.

Buzz This gives the option to operate the node buzzer upon receipt of a network event.

When panels are networked together, they share locally occurring events with other nodes on the network. The
following are the panel event types that can be processed.

l Fire
l CO
l Aux
l PreAlarm
l Trouble
l Disablement
l Supervisory
l Test
l Status - Reset, Resound, Silence Network Command

The network processing hierarchy is as follows, where NODE NUMBER represents a networked node.
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Each network event type received from
networked nodes are processed based on
the network interface configuration.

The event type is processed by other panels
based on the network interface
configuration.When items are checked, the
panel will process an incoming event for
each type listed.When event types are
unchecked, the panel will ignore incoming
events for each network type unchecked.

GLOBAL CLASS B NETWORK NODE ADDRESSES

The First Node Address and Last Node Address are used to identify network nodes on either side of a network
Class B SLC on supervised networks.
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Loop Data Tab

Set the number of loops installed in the FACP in the Loop Data tab. The number of loopsmust be entered when
users do not use panel export.

NUMBER OF LOOPS
Button.

NOTE OnMulti-Protocol panels, select either the
Hochiki or Apollo protocol.

Assign an address number to the loop card. The
default is the next number in the sequence.

Review the address numbers before sending the
data to the panel. If the information does not match
the hardware, the panel will have errors and an
updated configuration will need to be transferred.

LOOP OFFSET
Check Box.

Checking this boxwill offset all panel loops by the
total of the previous loop count. This is typically used
whenmore than one panel is installed on a network,
so that the loop numbering will be sequential across
several panels. The changes to the loop numbering
will be shown in the Network Tree and all other
placeswhere loop numbers are displayed.

EXAMPLE A network has three panels, with 4 loops
each. If Panels 2 and 3 are offset, Panel 2 loops
would change to loops 5,6,7,8 and Panel 3 loops
would change to 9,10,11,12.

DISPLAY USAGE
Radio Button. Allowed values areDevices andSub
Points.

This changes the display in the loop table to show
either the number ofDevices on the loop or the
number of Sub Points.
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LOOP DATA TABLE

This section of the Loop Data tab displays all loop
cards that have been added to the network.

l The Board drop-down sets the address for each
card.

l The Description displays what loops are assigned
each address.

l The Device / Sub Address Usage displays how
many devices or subaddresses are in use on each
loop address.

l The logo indicates the assigned protocol for each
loop address. Multi-protocol networks will also have
a radio button that allows a card to be assigned to an
alternate protocol.
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Misc Tab
YEAR | MONTH | DAY | HR | MIN

Up / Down Arrows. Allowed values are:

l Year - 2000 - 2200
l Month - 1-12
l Day - 1-31 (month-dependent)
l Hr - 0-23
l Min - 0-59

This is the date when panel maintenance is due.

MAINTENANCE MESSAGE
Text Box. Unlimited characters. Special characters
are allowed.

This is themessage that should appear when
maintenance is due.

FAULT INDICATIONS
Check Box.

This setting determines if the panel should post a
Troublemessage when panel maintenence is due.

PRESENT
Drop-Down List. Allowed values areYes orNo.

This setting indicates if a network card is connected.
Set this field to Yeswhen a panel with a network
card is installed, but not networked to other control
units.
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PANEL ID
Text Box.

This is the IP address of the panel.

MASK
Text Box.

This is the subnet mask of the panel.

GATEWAY
Text Box.

This is the ethernet gateway of the panel.

PANEL CUSTOM QUIESCENT SCREEN

This is where the custom quiescent screen
information is displayed. To add a new quiescent
screen, use the Transfer Quiescent Screen tool.
Then, select the new screen from this window,
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Delay Exceptions Tab

This tab contains a list of all devicesnot using the delays set in the Panel Data tab. This list can be sorted by
column. The Ignore Global Delays column check box can be checked to configure all listed devices to ignore
the set delays.
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Elite, Elite RS, eLAN RS, FireNET, FireNET+, FireNET LCD Network Annunciator

Panel Data Tab
NAME
Text Box, up to 30 characters allowed, including special
characters.

This is the name of the selected panel.

PANEL ADDRESS
Drop-down List. Allowed values are 1-64.

This is the node number of the panel on amulti-panel
Network. The first panel added to the configuration will be
assigned an address of 01. Subsequent panels added will be
assigned the next available address number, or a specific
address can be selected from the drop-down box.

ACCESS LEVEL 3 CODE
Up / Down Arrows. Each box has allowed values of 1 - 4.

This is the code to access user level 3 options.
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ACCESS LEVEL 2 CODE
Up / Down Arrows. Each box has allowed values of 1 - 4.

This is the code to access user level 2 options.

SILENCE BUZZER AT LEVEL 2
Check Box

Check this box to allow a Level 2 user to silence the panel
buzzer.

Hochiki America Corporation
Loop Explorer 2 User Guide

Version 1.00 |   June 2021 |   MAN-701
Page 124

Panel Configuration



LOOP PROTOCOL
Informational Only. This displays the currently-selected
protocol.

GLOBAL PATTERN
Drop-Down List. Allowed values areContinuous (high
steady state),MarchCode (high and low for even intervals),
and Temporal (synchronized on a system basis).

This will set the pattern that will be assigned to a NAC
circuit output pattern.

GRAPHICS SYSTEM
Check Box.

Selecting this option will alert the panel anel that Guide /
Graphix are present and to report when the software is no
longer communicating with the panel.
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PANEL TEXT
Text box. Up to 80 characters, including special characters.

This will provide site location details that will be displayed on
theGUI of all panels on the network when events are
generated on the panel.

NUMBER OF LOOPS
Radio Button. Allowed values are panel-dependent.
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LOOP OFFSET
Check Box.

Checking this box will offset all panel loops by the total of
the previous loop count. This is typically used whenmore
than one panel is installed on a network, so that the loop
numbering will be sequential across several panels. The
changes to the loop numbering will be shown in the Network
Tree and all other places where loop numbers are displayed.

EXAMPLE A network has three panels, with 4 loops each.
If Panels 2 and 3 are offset, Panel 2 loops would change to
loops 5,6,7,8 and Panel 3 loops would change to 9,10,11,12.

GENERAL ALARM
Radio Button. Allowed values areCommon (The panel will
activate all notification appliances zones when any General
alarm activation occurs.) and Zonal (The panel will activate
a general alarm for notification appliances ONLY in the same
zone as the activation point. If a subsequent point of
activation is in another zone, all notification appliances in
that zone will be activated.)

This sets how the panel will respond to a single general
alarm activation.
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SUB ADDRESSES

This displays the number of sub addresses in use and the
number available. The number of subaddresses available
will change, depending on the number of loops on the
network.

The usage bar changes as subpoints are added or deleted on
the loop. Total devices is also shown.
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Times Tab

This tab allows the configuration of set timed features common to panel operations.

DAY - START TIME |     DAY - END TIME
Up / Down Arrows. Any time of day (24 hour time format) is
allowed, incremented inminutes.

The start and end times are used to define the Day and Night
mode of the panel. At the onset of the Start time, the
detector's Day sensitivity is used. At the onset of the End
time, the detector's Night sensitivity is used.

RELEASE TIMER
Drop-Down List. Allowed values are 0-60.

The delay between the activation of amodule and
extinguishant release.

ACTIVATION PULSE TIME
Drop-Down List. Allowed values are Latching, 5, 10, 15, 20,
25, or 30.
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SOUNDER TIME-OUT
Drop-Down List. The panel default is 0, which disables this
feature. Allowed values are 5 to 60minutes, in 5minute
increments.

This programs the NAC circuits to automatically silence
after a period of time.

AC FAILURE REPORT DELAY
Up / Down Arrows. Allowed values are 0-240minutes. The
default is 60minutes.

This programs the panel to delay panel trouble reporting.
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DAYLIGHT SAVINGS
Enabled. Check Box.

Start / End Date. Calendar Pop-Up.

This sets the panel to use daylight savings time, starting and
ending on the dates selected for the current year. Future
years will be calculated automatically.

CALIBRATE SENSORS DAILY
Up / Down Arrows. Only theHours field can be edited.

This sets time each day when the sensors will perform their
calibration routine. Calibration occurs once per day should
be set to a time when building environmental conditions are
most stable.

ALARM VERIFICATION
Up / Down Arrows. Allowed values are between 5-60
seconds, in 5 second increments.

This sets the timing delay for the verification period.

NOTE This field will be disabled untilAlarm Verification
is set in the NetworkSettings.
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Network Interface Tab

The network interface tab is available in the panel settingsmanager of networked panels. This tab is disabled for
panels on a single node network.

TheNetwork Interface tab allows a user to select which network events that a panel will respond to, and define
the way in which it will respond. All other panels, aside from the currently-edited panel, will be listed. Click + to
expand the properties of the node and select how the panel will respond to network events. Each panel can have
a unique profile that defines how it will respond to the rest of the nodes and event types on the network.

Action Description
Process This instructs the node receiving a network event to behave exactly as it would if it were a local node event. For
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Action Description
example, in the even tof, the panel would be expected to activate the NAC outputs and fire relays. Selecting the
Process option ensures that the panel does this from network fire events. If the process option is not selected, the
panel would not process the event as a local event and would not activate the NAC outputs or fire relays when a
fire event is received from the network.

Display This option instructs the node receiving the network event to display the event on the LCD display exactly as it
would if it were a local node event.

Log
This gives the option to store the network event in the local node event log. For example if a panel is designated as
amaster panel, it may be required that the panel logs all events on the network, whereas other panels log only
their own events. Each node can store up to 500 events in the event log.

Print
This gives the option to print the network event. The node will print local events and network events assigned to it.
It is possible that amaster panel can be required to print all events (both local and network wide), while other
panels print only local events.

Buzz This gives the option to operate the node buzzer upon receipt of a network event.

When panels are networked together, they share locally occurring events with other nodes on the network. The
following are the panel event types that can be processed.

l Fire
l Emrg
l Aux
l PreAlarm
l Trouble
l Disablement
l Supervisory
l Test
l Status - Reset, Resound, Silence Network Command

FireNET Vision, L@titude Vision, Compas Vision

Panel Data Tab
NAME
Text Box, up to 30 characters allowed, including special
characters.

This is the name of the selected panel.
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PANEL ADDRESS
Drop-down List. Allowed values are 1-64.

This is the node number of the panel on amulti-panel
Network. The first panel added to the configuration will be
assigned an address of 01. Subsequent panels added will
be assigned the next available address number, or a
specific address can be selected from the drop-down box.

TIME ZONE
Drop-Down List. Allowed values include all global time
zones.

This sets the appropriate time zone. The default shown
here will match the time zone set inEdit Preferences.

PANEL TEXT
Text box. Up to 80 characters, including special
characters.

This will provide site location details that will be displayed
on theGUI of all panels on the network when events are
generated on the panel.
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Network Interface Tab

TheNetwork Interface tab allows a user to select which network events that a panel will respond to, and define
the way in which it will respond. All other panels, aside from the currently-edited panel, will be listed. Click + to
expand the properties of the node and select how the panel will respond to network events. Each panel can have
a unique profile that defines how it will respond to the rest of the nodes and event types on the network.

Action Description

Process

This instructs the node receiving a network event to behave exactly as it would if it were a local node event. For
example, in the even tof, the panel would be expected to activate the NAC outputs and fire relays. Selecting the
Process option ensures that the panel does this from network fire events. If the process option is not selected, the
panel would not process the event as a local event and would not activate the NAC outputs or fire relays when a
fire event is received from the network.

Display This option instructs the node receiving the network event to display the event on the LCD display exactly as it
would if it were a local node event.

Buzz This gives the option to operate the node buzzer upon receipt of a network event.

When panels are networked together, they share locally occurring events with other nodes on the network. The
following are the panel event types that can be processed.

l Fire
l CO
l Aux
l PreAlarm
l Trouble

l Disablement
l Supervisory
l Test
l Status - Reset, Resound, Silence Network Command
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Misc Tab
PANEL ID
Text Box.

This is the IP address of the panel.

MASK
Text Box.

This is the subnet mask of the panel.

GATEWAY
Text Box.

This is the ethernet gateway of the panel.

PANEL CUSTOM QUIESCENT SCREEN

This is where the custom quiescent screen information is
displayed. To add a new quiescent screen, use the Transfer
Quiescent Screen tool. Then, select the new screen from
this window,
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Panel I/O Configuration
Inputs

1. Choose an Input Action. This will determine the
default Input Action Message.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.
6. Each input circuit is Normally Open, but Closed upon

activation. Selecting Input Invert will set the circuit to
be Normally Closed, but Open upon activation.

Outputs

NACs
Refer to NAC Module Properties details for
instructions on configuring the NAC Outputs.
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Other Outputs
1. Select the desired Output Options. This selection will

activate the circuit when the selected event(s) occur.
2. Set whether the output will be Silenceable. Each

channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active.

3. Each output circuit is SPST. Outputs are normally-
open (N.O.) and close upon activation. Selecting
Output Invert will set the output circuit to be normally-
closed (N.C.); inverted outputs open upon activation.
During times of complete power loss (loss of both
normal and backup power), all outputs will open
regardless of their configuration settings. Inverting an
output does not change the quiescent current
consumption of the panel module.

4. Ignore Global Delays. This setting controls the delay
of the activation of the output. If unchecked, it will
activate based on the Global Delay settings in the
Panel Settings. If checked, it will activate based on the
settings in the First Delay and Second Delay fields.
Second Delay is only visible if the output is
silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.

5. Enter a Duration to select how long an output will be
active. If set to 0, it will remain active until the system is
reset.

6. Where applicable (this field does not exist on every
output), set the Pattern using the drop-down box.
Allowed values are Continuous (high steady state),
March Code (high and low for even intervals),
Temporal (synchronized on a system basis, three
even on/off cycles followed by off period), and Panel
Global Pattern (will follow the panel pattern setting,
configured in the panel settings).
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Function Button Configuration
1. Choose an Input Action.
2. Select which Feature Groups can access this function

button.
3. Input Action Message is automatically set based on

the selected Input Action. If desired, a custom Input
Action Message can be entered.

4. Check the Output DelayBypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Use the drop-down box to select a Color for the
function button.

6. Set the Input Delay in seconds, up to 180 seconds.
Input activation will prevent the panel's response for
specified time period when the input is activated. No
activation will occur if the input state is reset to normal
before time period expires.

7. Set the Input Latch to Latching or Non-latching.
8. Each input circuit is Normally Open, but Closed upon

activation. Selecting Input Invert will set the circuit to
be Normally Closed, but Open upon activation.

Hochiki America Corporation
Loop Explorer 2 User Guide

Version 1.00 |   June 2021 |   MAN-701
Page 139

Panel Configuration



MODULE CONFIGURATION
Module Configuration will depend on the site, customer, and local authority requirements. When new modules
are added, LE2 will add applicable configuration items. Double-click these items to access themodule
configuration settings.

L@titude and Compas Modules 141

4 Channel NAC Module 141

8 Channel Conventional ZoneModule 145

8 Channel RelayModule 147

16 Channel I/O Board and Panel Module 148

Media GatewayPanel Module 151

Legacy Panel Modules 155

eView Serial Annunciator / FireNET LCD-S 155

16 Channel I/O Board 156

Dialer 157

eMatrix / Mimic 159

eMatrix / Mimic 16WayCard Expansion Kit 161

XT+ Module 162
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L@titude and Compas Modules
4 Channel NAC Module

NAC Module Properties

Double-click the 4 Channel NAC Module in the network tree to configure the NAC module.

1. If desired, enter a custom Name for the module that will be displayed in the network tree.
2. Using the drop-down box, set the Address for the module from 1 - 32.
3. Set the Circuit Current Limit, between 0.5 A- 2.3 A. This is the maximum current that can be provided by each circuit.

This setting applies to all output circuits of this module, whether Class A or Class B. The default setting is 2.3 A.

NOTE Themaximum operating current for all 4 channels combined is 5 A.

4. Set theWiring Class to A or B for each circuit. Wiring class can only be selected in output pairs. When Class A is
selected, the output pair forms a single circuit. When Class B is selected, the output pair forms two independent circuits.

By default, all circuits are programmedClass B.When circuits are wired Class A but not programmed tomatch
(and vice versa), circuits will report wiring trouble.

Channel Properties

Double-click the individual NACs under the 4 Channel NAC Module in the network tree to configure each
channel.
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1. Notification Circuit Parameters. TheNotification Circuit Parameter should be selected first because it
defineswhich output will be used. This portion of the window will display different options based on which
output type is selected. They are:

l Pattern Output (default)
l Strobe Output
l Power Output

l To silence horns only, check Silenceable and Strobe Output.
l To silence horns and strobes, check Silenceable, Strobe Output, and Strobe Silence.
l To configure a Temporal or Continuous 24V output, check Pattern Output and select Panel Global Pattern or
Continuous from the Pattern drop-down menu. Set the Panel Global Pattern under Panel Settings to Temporal.

NOTE To silence the Pattern Output, check the Silenceable box.

l To configure the output to supply 24V power for a non-NAC application, uncheck all Notification Circuit Parameter
checkboxes. Select Continuous, Door Holder, or Resettable from the AUX 24V DC drop-down menu.

Pattern Output
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l To configure a continuous 24 V output (i.e., to power one or more
notification appliances that are not required to be synchronized)
during activation, select Pattern Output, then Continuous from the
Pattern drop-down menu.

l To configure a pulsing 24 V output (i.e., to power a simple bell) during
activation, select Pattern Output, then Panel Global Pattern from the
drop-down menu. This selection will follow the panel pattern setting,
configured in the panel settings.

Strobe Output

To use a built-in manufacturer's synchronization protocol, select
Strobe Output and select an option from the drop-down box. By
default, the AlarmSilence button on the panel will silence only
horns. SelectStrobe Silence to configure the AlarmSilence
button to silence the horns and strobes.

Power Output

To configure the output to supply power for a non-
NAC application, all boxesmust be unselected. The following
options are available from the AUX 24V DC drop-downmenu.

l Continuous Constant Power - Continuous constant power provides
a voltage output comparable to AUX 24V.

l Door Holder - Door Holder outputs lose power during fire alarm
conditions and/or during AC power loss.

l Resettable - Resettable causes power loss that lasts 4-5 seconds
each time the panel is reset.

2. Select the desired outputOptions. This selection will
activate the circuit when the selected event(s) occur.
To use cause and effect programming, LE2 must be
used for configuration and all output options must be
deselected.

3. Set whether the output will be Silenceable. Each NAC
is configurable in reaction to the Alarm Silence button
on the front panel. Check the box if the NAC should
return to normal standby when Alarm Silence is active.

4. Each output circuit is SPST. Outputs are normally-
open (N.O.) and close upon activation. Selecting
Output Invert will set the output circuit to be normally-
closed (N.C.); inverted outputs open upon activation.
During times of complete power loss (loss of both
normal and backup power), all outputs will open
regardless of their configuration settings. Inverting an
output does not change the quiescent current
consumption of the panel module.

5. Ignore Global Delays. This setting controls the delay
of the activation of the output. If unchecked, it will
activate based on the Global Delay settings in the
Panel Settings. If checked, it will activate based on the
settings in the First Delay and Second Delay fields.
Second Delay is only visible if the output is
silenceable.
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NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.

6. Enter a Duration to select how long an output will be
active. If set to 0, it will remain active until the system is
reset.

7. Set the Location Text, up to 80 characters. This text is
displayed when the circuit reports trouble and is the
name of the channel displayed in the network tree.

8. Use the Map to Zone field to set the zone number for
the circuit. Allowable values depend on the network
configuration.
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8 Channel Conventional Zone Module

Module Properties

Double-click the 8 Channel Conventional ZoneModule in the network tree to configure themodule.

1. If desired, enter a custom Name for the module that will be displayed in the network tree.
2. Using the drop-down box, set the Address for the module from 1 - 32.

Input Configuration

Double-click each Detection Zone under the 8 Channel Conventional ZoneModule in the network tree to
configure the inputs.

1. Choose a Device Setting from the drop-down list.
The default setting is Detector.

NOTE This step must be done first, as it will
affect the remaining configuration selections.

2. Choose an Input Action. The default setting is Fire.
For the default device setting (Detector), the setting
can be changed to Supervisory or Carbon
Monoxide. Other device settings will have different
allowable input actions available, based on each
device's capabilities and limitations.

3. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured
delays.

5. Set the Input Delay in seconds, up to 180 seconds.
This setting delays the panel's response to an
activation. No panel response will occur if the input
state is restored to normal before time period
expires. A non-latching input will not activate if
restored before the time period expires.

6. Set the Input Latch field to Latching or Non-latching.
7. Set the Short Circuit Activation field to Yes or No.

Hochiki America Corporation
Loop Explorer 2 User Guide

Version 1.00 |   June 2021 |   MAN-701
Page 145

Module Configuration



l When set to yes, a short on the circuit results in
activation.

l When set to no, a short on the circuit results in a
trouble. To cause an activation, a trigger resistor
must be used.

8. Set theWiring Class to A or B for each circuit. Wiring
class can only be selected in input pairs. When
Class A is selected, the input pair forms a single
circuit. When Class B is selected, the input pair
forms two independent circuits.

9. Set the Location Text, up to 80 characters. This text
is displayed when the circuit is activated.

10. Use the Map to Zone field to set the zone number for
the circuit. Allowable values are dependent on the
network configuration.

The circuit will not follow alarm verification zone
settings.
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8 Channel Relay Module

Module Properties

Double-click the 8 Channel RelayModule in the network tree to configure themodule.

1. If desired, enter a custom Name for the module that will be displayed in the network tree.
2. Using the drop-down box, set the Address for the module from 1 - 32.

Output Configuration

Double-click each relay under the 8 Channel RelayModule in the network tree to configure the outputs.

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active. If this box is checked, the Second
Delay field is displayed.

3. Each output circuit is SPST. Outputs are normally-open
(N.O.) and close upon activation. Selecting Output
Invert will set the output circuit to be normally-closed
(N.C.); inverted outputs open upon activation. During
times of complete power loss (loss of both normal and
backup power), all outputs will open regardless of their
configuration settings. Inverting an output does not
change the quiescent current consumption of the
panel module.

4. Enter a Duration to select how long an output will be
active. If set to 0, it will remain active until the system is
reset or silenced (configuration-dependent).

5. Set the Location Text, up to 80 characters.
6. Use the Map to Zone field to set the zone number for

the circuit. Allowable values are dependent on network
configuration.
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16 Channel I/O Board and Panel Module

Module Configuration

Double-click the 16 Channel I/O Module in the network tree to configure themodule.

1. If desired, enter a custom Name for the module that will be displayed in the network tree.
2. Using the drop-down box, set the Address for the module from 1 - 32.
3. Use the radio buttons to set each channel to be an input or output.
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Channel Properties

For channels set as Outputs

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active. If this box is checked, the Second
Delay field is displayed.

3. Each output circuit is SPST. Outputs are normally-
open (N.O.) and close upon activation. Selecting
Output Invert will set the output circuit to be normally-
closed (N.C.); inverted outputs open upon activation.
During times of complete power loss (loss of both
normal and backup power), all outputs will open
regardless of their configuration settings. Inverting an
output does not change the quiescent current
consumption of the panel module.

4. Ignore Global Delays. This setting controls the delay
of the activation of the output. If unchecked, it will
activate based on the Global Delay settings in the
Panel Settings. If checked, it will activate based on the
settings in the First Delay and Second Delay fields.
Second Delay is only visible if the output is
silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.

5. Enter a Duration to select how long an output will be
active. If set to 0, it will remain active until the system is
reset.

6. Set the Location Text, up to 80 characters.
7. Use the Map to Zone field to set the zone number for

the circuit. Allowable values are dependent on
network configuration.
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For channels set as Inputs

1. Choose an Input Action.
2. Input Action Message is automatically set based on

the selected Input Action. If desired, a custom Input
Action Message can be entered.

3. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

4. Set the Input Delay in seconds, up to 180 seconds.
Input activation will prevent the panel's response for
specified time period when the input is activated. No
activation will occur if the input state is reset to normal
before time period expires.

5. Set the Input Latch to Latching or Non-latching.
6. Each input circuit is Normally Open, but Closed upon

activation. Selecting Input Invert will set the circuit to
be Normally Closed, but Open upon activation.

7. Set the Location Text, up to 80 characters. This text is
displayed when the circuit is activated.

8. Set the desired Map to Zone number for the circuit.
Allowable values are dependent on network
configuration.
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Media Gateway Panel Module

Dialer Tab
1. Select a Line Type. This is the method used by the

Media Gateway to dial. Options are Tone, Pulse, or
Both.

Tone is the preferred in most installations. However,
depending on your location, Tone may not be
supported. When Both is selected, the Media Gateway
first attempts Tone dialing. If that fails, Pulse will be
attempted. Both can be selected during
troubleshooting, but is not recommended for the final
installation.

2. Select the line(s) that should be monitored. Phone line
monitoring is optional since the phone lines may not
be connected.

All phone lines that are in use must be monitored.
Phone lines that are not monitored will not be used.
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Accounts Tab

For each account,

1. Select either Dialer or Sur-Gard FIBRO for the
Transport Medium. Dialer will use the phone line
pathways; Sur-Gard Fibro will use Ethernet.

l If Dialer is selected,

a. Set the Account Number that will be used to identify
the particular site to which the Media Gateway sends
data. The account number must be between 4-6 digits.

b. Set the Phone Number(s) of the receiver (monitoring
station). An optional second number may be entered.
Each number can be up to 30 digits. If a pause is
needed, insert a "," character. To wait for a secondary
dial tone, insert a "w" character.

l If Sur-Gard Fibro is selected,

a. Set the Account Number that will be used to identify
the particular site to which the Media Gateway sends
data. The account number must be between 4-6 digits.

b. Enter a DSC IP Address. This is the IP address of the
Sur-Gard FIBRO receiver. This should be obtained
from your central station.

c. Enter the Local Port Number. This is the local port
number of the Sur-Gard FIBRO receiver. This should
be obtained from your central station.

d. Enter the Remote Port Number. This is the remote
port number of the Sur-Gard FIBRO receiver. This
should be obtained from your central station.

e. Select whether the connection is Supervised. When
supervision is enabled, the panel monitors the
connection to the central station.

f. Enter the Advanced Encryption Standard (AES) Key,
up to 32 characters.

g. For reporting code modification, contact technical
support.

2. Select Contact ID or SIA for the Protocol. This is the signaling method that will be used to transfer data to the receiver
(monitoring station). If Contact ID is selected, select either Simple or Detailed reporting.

3. Set the time for a test signal to be sent. The Time field is for the time of day in 24-hour format.
4. Set the Frequency interval of the test signal . Valid options are 6, 12, 18, or 24 hours.
5. Set a time delay before the Media Gateway reports an AC Power Failure. Valid values are 0 - 180 minutes.
6. Select whether to report by Point (device) or by Zone. Zone reporting sends the same signal for all points in the zone,

therefore the central station will not be able to differentiate between different points in the zone. Point reporting provides
more specific location information. When selecting to report by Point, Contact ID may not report points above 99 or loops
in excess of 9 accurately. SIA is the preferred transmission protocol.

7. Choose the panel event types that the Media Gateway will transmit to the receiver. This is user-configurable for any
given setup. For example, it enables Account 1 to report alarms to one central station and Account 2 to report trouble
signals to another station.

Account 2 can be used as a backup to Account 1. To set an account as a backup, select Backup Reporting for Account
2 and de-select all other event types. When a transmission fails using the primary account, the panel will attempt
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communication using the backup account.

LAN Tab

These fields are common parameters that are a function of the LAN through which theMedia Gateway is
connected. Contact your network administrator for appropriate settings.

Graphics / Third Party Tab

1. Check the Off box to set whether MCE is off or on.
2. Enter the Server Name.
3. Enter the Port Number. The default setting is 100.
4. Enter the Max Pending. This is used to specify the

maximum number of events that the Media Gateway
may store before sending them. This will almost
always be set to 1, so events are sent as they happen,
unless there is some specific communication problem
to be overcome.

5. Enter the Monitoring Period. This is the amount of
time (in seconds) that the heartbeat will be sent after
activation of connection monitoring. The default is 20
seconds.

6. Enter the Monitoring Grace Period. This is the amount
of time (in seconds) before the alarm is triggered. The
default is 5 seconds.

7. Check the Off box to set whether Evax is off or on.
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Advanced Configuration Tab

Refer to theMedia Gateway Panel Module (S788) Functionality and Configuration Guide (MAN-
1483HA) for details on this feature.
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Legacy Panel Modules
eView Serial Annunciator / FireNET LCD-S

1. If desired, enter a Name for the eView Serial Annunciator. Up to 20 characters are permitted and special characters are
allowed.

2. Assign an address using the Address drop-down box, between 1-15.
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16 Channel I/O Board

Refer to 16 Channel I/O Board for configuration instructions.
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Dialer

Dialer Tab

1. Enter the Site Number. This is the phone number connected to the panel. Up to 20 characters are permitted and special
characters are allowed.

2. Enter up to 4 Phone Numbers for the Central Station Receiver. Up to 24 characters are permitted, 0-9 and (,). Inserting a
"," before the start of the phone number will insert a 3 second pause before dialling.

3. Select a Line Type. This is the method used by the Dialer to dial. Options are Tone, Pulse, or Both. Tone is the preferred
in most installations. However, depending on the location, Tone may not be supported. When Both is selected, the Dialer
first attempts Tone dialing. If that fails, Pulse will be attempted. Both can be selected during troubleshooting, but is not
recommended for the final installation.

4. Select the line(s) that should be monitored. Phone line monitoring is optional as the phone lines may not be connected.
All phone lines that are in use must be monitored. Phone lines that are not monitored will not be used.

5. Select the Number of Rings allowed before hanging up. Allowed values are between 2 - 9.
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Accounts Tab

1. Set the Test Code Time (in 24 hour format) for the daily test call with the Central Station Receiver. The dialer will call the
receiver at the configured time to verify connectivity and report status.

2. Select whether to Report By Point (device) or by Zone. Zone reporting sends the same signal for all points in the zone,
therefore the central station will not be able to differentiate between different points in the zone. Point reporting provides
more specific location information.

When selecting to report by Point, Contact ID may not report points above 99 or loops in excess of 9 accurately when
Simple Reporting is selected. SIA is the preferred transmission protocol.

3. For each account (1-4),

l Set the Account Number that will be used to identify the particular site to which the Dialer sends data. The account
number must be 4 digits.

l Choose the panel event types that will be transmitted to the receiver. This is user-configurable for any given setup. For
example, it enables Account 1 to report alarms to one central station and Account 2 to report trouble signals to another
station.

Account 2 can be used as a backup to Account 1 (and Account 4 as a backup to Account 3). To set an account as a
backup, select Backup Reporting for Account 2 (or 4) and de-select all other event types. When a transmission fails
using the primary account, the panel will attempt communication using the backup account.

l Select Contact ID or SIA for the Protocol. This is the signaling method that will be used to transfer data to the receiver
(monitoring station).
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eMatrix / Mimic
1. If desired, enter a custom Name for the eMatrix module.
2. Select the desired Address, between 1 - 32.
3. Select the desired Mimic LED Mode. These modes control the

LED blink behavior. Options are:

l Flash first activated output and subsequent to continuous: The
first LED to activate will flash. Subsequent LEDs will illuminate
continuously.

l Continuous on first activated output and subsequent to
flash: The first LED to activate will illuminate continuously.
Subsequent LEDs will flash.

l Flash outputs until silenced: All LEDs will flash.
l All outputs continuous: All LEDs will illuminate continuously.

Zone Properties

The eMatrix can assign up to 8 LED zones using the individual
zone output property configuration windows. Each of these 8
zone LEDs can be added to a cause and effect and assigned a
unique zone number from 0-500.

1. Select the panel events that will trigger the LED to activate.
2. Enter the desired Location Text, up to 80 characters.
3. Assign the LED zone a unique zone number between 0-500.
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eMatrix / Mimic 16 Way Card Expansion Kit

This is an optional expansion card for the eMatrix, which can expand the zone capability to 24 total zones. Each
expansion card can be assigned an eMatrix (whenmultiple are in use) and a unique address number. Zones are
configured the sameway as the eMatrix zones.

1. If desired, enter a custom Name for the expansion card.
2. Assign an Address from 1-32.
3. When multiple eMatrix units are in use, use the drop-down box to select the address of the connected module.

Zone Properties

Refer to eMatrix Zone Properties for details on configuration the zones for the 16WayExpansion Kit.
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XT+ Module

Amaster FACPmust be configured, and then up to 15 XT+ modules can be added.

Item Description Value LE2 Default

Name This is the name used by LE2 to refer to the
XT+ Module. XT+ Module <#>

VF1711-#0Multi-Area
Addressable Releasing Control
Module 1 Area

First Activation Zone The lowest numbered zone in the releasing
area for this module. 1-500 1

Last Activation Zone The highest numbered zone in the
releasing area for this module. 1-500 2

Address The address of themodule. 1-15 1

The releasing area of amodulemust consist of one or more sequentially numbered zones. This range of zones is
defined by the first and last activation zones. Initiating deviceswhich are in this range of zones and are connected
directly to the same panel as the XT+ will be the only devices that will initiate a release.When configured for
coincidence, any two of these deviceswill initiate a release. Devices outside this range or connected to other
network panels will not initiate a release.

Times Tab

Item Description Value LE2 Default

Reset Lock-Out Time The length of time before the extinguishant outputs can be
reset.

0 - 30
minutes 0minutes

Release Delay The delay between the activation of amodule and 0 - 60 30 seconds
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Item Description Value LE2 Default
extinguishant release. seconds

Release Duration The length of time the extinguishants are released. 60 – 500
seconds 120 seconds

Disablements Tab

Item Description Value LE2 Default
Release Timer This disables the "Release Duration" above setting. Enabled or Disabled Enabled
Ground Trouble This disables ground troublemonitoring. Enabled or Disabled Enabled
Trouble Output The trouble relay on eachmodule can be disabled. Enabled or Disabled Enabled
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Settings Tab

Item Description Value LE2 Default

Stage Two Alarms The second stage alarm NAC output can be
set to activate pulsed or steady.

Pulsed (Temporal 3)
Steady Steady

Stage Three Alarms The third stage alarm NAC output can be set to
activate pulsed or steady.

Pulsed
Steady Pulsed

Release Indication

The Release Pressure Switch is normally
used, but can be bypassed to use the
Extinguishing Output when no pressure switch
is available.

Release Pressure
Switch
Extinguishing Output

Release Pressure
Switch

Release Pressure
Switch Mode

This can be used to invert the action of the
Release Pressure Switch input when a
normally closed Pressure Switch is available.

Normal
Invert Normal
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Item Description Value LE2 Default
Pre-Release Delay on
Manual Activation

This can be used to eliminate the countdown
whenmanually releasing the extinguishant.

Delay
NoDelay Delay

R0V Removed on Reset

The Aux24V output supply can be configured
such that the R0V (negative) is removed for
around 5 seconds when themodule is reset.
This is typically used to reset ancillary items
such as beam detectors which need a power
cycle to reset them.

Yes
No No

Low Pressure Switch Mode

This can be used to invert the action of the Low
Pressure Switch input.

For UL compliance, this field must be set to
Normal.

Normal
Invert Normal

Language
Somemodules are factory fitted with an
alternate language to English. The alternate
language can be used by selecting Other.

English
Other English

Output Mode

When set to Common, the two extinguishing
outputs are released at the same time. When
set to Main / Reserve, output 1 will release and
aMain / Reserve selection option appears at
Access Level 2. The Reserve Cylinders LED
will be illuminated and output 2 will release
during the next activation.

Common
Main / Reserve Common

ActivationMode

By default, two devices (Coincidence) must be
active for amodule to enter the Activated
condition. This setting can be used to allow any
Single active device to cause themodule to
enter the Activated condition.

IMPORTANT! Initiating devices must
be connected directly to the same panel
as the XT+ Releasing Control Unit.
(Devices in the same zone connected to
other network panels will not initiate a
release.)

Coincidence
Single Coincidence

User Output Mode This changes the function of the of the Supv
terminal.

Supervisory
Abort Supervisory

Abort Mode

Abort switches are not permitted on systems
intended to perform pre-action or deluge water
functions.

For UL compliance, this field must be set to
Abort.

Abort
Hold Abort
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When theManual Release input is configured for no delay, it will override an active Abort input. When the
Manual Release input is configured for pre-release delay, it will override an active Abort input and cause the
countdown to resume.
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DEVICE CONFIGURATION
Configuration instructions for each device are provided in the sections below. In addition to the fields described
below, each window also contains a Location Text andMap to Zone field. Enter up to 80 characters for
location text. This text is displayed when the circuit is activated. Use theMap to Zone field to set the zone number
for the circuit. Allowable values are dependent on the network configuration.

Somewindows have one or two additional buttons as
shown here.

Change Address. Use this option to change the
address of the device.

Device Installed. Use this option to toggle the device
to be installed or uninstalled.

Device Settings / Input Actions 168

Hochiki Protocol 171

Audio Visual 171

Call Point 172

Modules 172

Pull Stations 184

Sensors 185

Sounders 196

Apollo Protocol 197

Audio Visual 197

Modules 200

Pull Stations 206

Sensors 208
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Device Settings / Input Actions
Each input has aDevice Setting and an Input Action.

l The Device Setting field describes the type of device that is connected to the input and determines the detailed response
to the activation.

l The Input Action field describes what type of action the panel should take in response to an activation of the input. These
fields are used together to define how the FACP reacts to activation of the input.

Depending on theDevice Setting, restrictions are set on which Input Action values are permitted. For
example, aDevice Setting ofManual Pull Station is restricted to an Input Action of Fire.

Depending on the Input Action selected, restrictions are placed on other parameter values. For instance, an
Input Action of type Fire can not be configured asNon-Latching.

A device setting ofGeneral Purpose N/O EOL allows the widest range of input actions. This selection will
transmit a signal based on the selected Input Action to the off-premisesmonitoring station, with a general event
typemessage. Available input actions for this setting are shown here:

l Fire
l Trouble
l Pre Alarm
l Supervisory

l Carbon Monoxide
l Auxiliary
l Silence
l Reset

l Transparent
l Disablement
l Test Mode
l Fire Drill
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This chart shows an example of L@titude / Compas fire signals sent for theDevice Setting of Detector (default)
and the three possible Input Actions (Fire, Supervisory, andCarbonMonoxide).

SelectingManual Pull Station as theDevice Settingwill also send a fire signal. This chart shows an example of
the signals sent for this setting and the only possible Input Action (Fire).

The device setting ofManual Pull Station enabled the panel to send amore specific CID fire event type (115
Manual Pull) to the off-premisesmonitoring station. The SIA communication protocol does not have amore
specific fire event type for amanual activation, so the SIA event type is the same in both cases.

A Device Setting ofWater Flow AlarmNon Silence restricts the operation of the AlarmSilence function. It will
also cause the event type being transmitted to an off-premisesmonitoring station to indicate amore specific fire
event type ofWaterflow.
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NOTE Note that the SIA and CID signals for Input Action: Fire differ in each of these examples. This
demonstrates how theDevice Setting determines the final, detailed response to the activation.
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Hochiki Protocol
Audio Visual

YBO-BSB2 Base

When adding the YBO-BSB2 Base to a configuration, select the
device(s) to host the base.

Once the base has been assigned to one or more devices, it can be configured by double-clicking the base in the
network tree.

1. Select the desired Output Options. This selection will activate the
circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each channel is
configurable in reaction to the Alarm Silence button on the front
panel. Check the box if the channel should return to normal
standby when Alarm Silence is active. If this box is checked, the
Second Delay field is displayed.

3. Ignore Global Delays. This setting controls the delay of the
activation of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked, it will
activate based on the settings in the First Delay and Second
Delay fields. Second Delay is only visible if the output is
silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on the settings
in the First Delay field.
- if the output is silenceable, subsequent re-sounding of the output will
be delayed based on the settings in the Second Delay field.

4. Enter a Duration to select how long an output will be active. If set
to 0, it will remain active until the system is reset or silenced
(configuration-dependent).
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Call Point

HCP-E

1. Choose an Input Action.
2. Input Action Message is automatically set based

on the selected Input Action. If desired, a custom
Input Action Message can be entered.

3. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its
associated outputs, even if those outputs have
configured delays.

4. Set the Input Delay in seconds, up to 180 seconds.
Input activation will prevent the panel's response for
specified time period when the input is activated.
No activation will occur if the input state is reset to
normal before time period expires.

5. Set the Input Latch to Latching or Non-latching.
6. Each input circuit is Normally Open, but Closed

upon activation. Selecting Input Invert will set the
circuit to be Normally Closed, but Open upon
activation.

Modules

CHQ-POM
Set the Fault Reporting Delay from 0 - 180 seconds.
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Output Properties

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active. If this box is checked, the Second
Delay field is displayed.

3. Delay This setting controls the delay of the activation
of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked,
it will activate based on the settings in the First Delay
and Second Delay fields. Second Delay is only visible
if the output is silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.

4. POM Programmable Settings.

l Current Limit. Use the drop-down box to select the
current limit from 2 mA to 32 mA.

l Output Normally On. Check the box to set the output
to default to "on". When the output is activated, it will
turn off.

l Drop on Reset. Check the box to momentarily drop
the voltage when a system reset occurs.

l Single Shot Mode. When this box is checked, upon
point activation, the output of the point will transition
from the "normal" state to the "activated" state for the
duration specified, and then return to the "normal"
state. The output will remain in the "normal" state until
after the point is restored. After the point is restored,
the process can reoccur.

l Output Duration. Use the drop-down box to set the
desired length of time that the output is activated.
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Input Properties

1. Choose an Input Action.
2. Input Action Message is automatically set based on

the selected Input Action. If desired, a custom Input
Action Message can be entered.

3. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

4. Set the Input Delay in seconds, up to 180 seconds.
Input activation will prevent the panel's response for
specified time period when the input is activated. No
activation will occur if the input state is reset to normal
before time period expires.

5. Set the Input Latch to Latching or Non-latching.

Hochiki America Corporation
Loop Explorer 2 User Guide

Version 1.00 |   June 2021 |   MAN-701
Page 174

Device Configuration



CLIM / VF6056-00,
CLIM2 / VF6057-00

Refer to Device Configuration for details about the
options in this window.

Input Properties 1. Set the Threshold settings for the input. Each
threshold may be set to a different value and a
different input action to allow for maximum current
monitoring flexibility and annunciation. Set a threshold
value and associated event for each Threshold field.
The allowed range is 3mA - 24mA. Each lower
threshold value must be less than or equal to the
value directly above. Once the module detects the
threshold limit, the associated event type is activated
on the panel.

2. Set the Input Latch to Latching or Non-latching.
3. Use the Device Setting drop-down box to set the

function of the module.
4. Check the Output Delay Bypass box if activation of

this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Delay in seconds, up to 180 seconds.
Input activation will prevent the panel's response for
specified time period when the input is activated. No
activation will occur if the input state is reset to normal
before time period expires.
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CZM / VF2011-00,
DIMM / VF6007-00,
FRCMA / VF6020-00,
FRCMA-I / VF6021-00,
FRCMA-P / VF6022-00,
FRCMA-PI / VF6023-00,
FRCME / VF6024-00

1. Choose a Device Setting from the drop-down list. The
default setting is Manual Pull Station.

NOTE This step must be done first, as it will
affect the remaining configuration selections.

2. Choose an Input Action. The default setting is Fire.
For the default device setting (Manual Pull Station),
the setting must be Fire. Other device settings will
have different allowable input actions available, based
on each device's capabilities and limitations.

3. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Delay in seconds, up to 180 seconds.
This setting delays the panel's response to an
activation. No panel response will occur if the input
state is restored to normal before time period expires.
A non-latching input will not activate if restored before
the time period expires.

6. Set the Input Latch field to Latching or Non-latching.
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MIOMH
Set theWiring Style to A or B for each circuit. Wiring
class can only be selected in input pairs. WhenClass
A is selected, the input pair forms a single circuit.
When Class B is selected, the input pair forms two
independent circuits.

Input Properties

1. Choose a Device Setting from the drop-down list. The
default setting is Manual Pull Station.

NOTE This step must be done first, as it will affect the
remaining configuration selections.

2. Choose an Input Action. The default setting is Fire. For the
default device setting (Manual Pull Station), the setting
must be Fire. Other device settings will have different
allowable input actions available, based on each device's
capabilities and limitations.

3. Input Action Message is automatically set based on the
selected Input Action. If desired, a custom message can
be entered.

4. Check the Output Delay Bypass box if activation of this
circuit should immediately activate its associated outputs,
even if those outputs have configured delays.

5. Set the Input Delay in seconds, up to 180 seconds. This
setting delays the panel's response to an activation. No
panel response will occur if the input state is restored to
normal before time period expires. A non-latching input
will not activate if restored before the time period expires.

6. Set the Input Latch field to Latching or Non-latching.
7. When theWiring Style is set to Class B, set whether the

circuit is normally open or normally closed.
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Output Properties

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active. If this box is checked, the Second
Delay field is displayed.

3. Delay.. This setting controls the delay of the activation
of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked,
it will activate based on the settings in the First Delay
and Second Delay fields. Second Delay is only
visible if the output is silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.
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MIOML
Set theWiring Style to A or B for each circuit. Wiring
class can only be selected in input pairs. WhenClass
A is selected, the input pair forms a single circuit.
When Class B is selected, the input pair forms two
independent circuits.

Input Properties

1. Choose a Device Setting from the drop-down list. The
default setting is Manual Pull Station.

NOTE This step must be done first, as it will affect the
remaining configuration selections.

2. Choose an Input Action. The default setting is Fire. For the
default device setting (Manual Pull Station), the setting must
be Fire. Other device settings will have different allowable
input actions available, based on each device's capabilities
and limitations.

3. Input Action Message is automatically set based on the
selected Input Action. If desired, a custom message can be
entered.

4. Check the Output Delay Bypass box if activation of this
circuit should immediately activate its associated outputs,
even if those outputs have configured delays.

5. Set the Input Delay in seconds, up to 180 seconds. This
setting delays the panel's response to an activation. No
panel response will occur if the input state is restored to
normal before time period expires. A non-latching input will
not activate if restored before the time period expires.

6. Set the Input Latch field to Latching or Non-latching.
7. When theWiring Style is set to Class B, set whether the

circuit is normally open or normally closed.
8. Each input circuit is Normally Open, but Closed upon

activation. Selecting Input Invert will set the circuit to be
Normally Closed, but Open upon activation.
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Output Properties

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active. If this box is checked, the Second
Delay field is displayed.

3. Each output circuit is SPST. Outputs are normally-
open (N.O.) and close upon activation. Selecting
Output Invert will set the output circuit to be normally-
closed (N.C.); inverted outputs open upon activation.
During times of complete power loss (loss of both
normal and backup power), all outputs will open
regardless of their configuration settings. Inverting an
output does not change the quiescent current
consumption of the panel module.

4. Delay.. This setting controls the delay of the activation
of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked,
it will activate based on the settings in the First Delay
and Second Delay fields. Second Delay is only
visible if the output is silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.

5. Enter a Duration to select how long an output will be
active. If set to 0, it will remain active until the system is
reset.
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R2M / VF6005-00,
R2MH / VF6054-00,
R2MH-I / VF6055-00,
R2ML / VF6052-00,
R2ML-I / VF6053-00

Refer to Device Configuration for details about the
options in this window.

Channel Configuration

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm Silence
button on the front panel. Check the box if the channel
should return to normal standby when Alarm Silence is
active. If this box is checked, the Second Delay field is
displayed.

3. Delay.. This setting controls the delay of the activation of
the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked, it
will activate based on the settings in the First Delay and
Second Delay fields. Second Delay is only visible if the
output is silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of the
output will be delayed based on the settings in the Second
Delay field.
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SOM / VF6004-00
Refer to Device Configuration for details about the
options in this window.

Channel Configuration

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active.

3. Each output circuit is SPST. Outputs are normally-
open (N.O.) and close upon activation. Selecting
Output Invert will set the output circuit to be normally-
closed (N.C.); inverted outputs open upon activation.
During times of complete power loss (loss of both
normal and backup power), all outputs will open
regardless of their configuration settings. Inverting an
output does not change the quiescent current
consumption of the panel module.

4. Set the Pattern using the drop-down box. Allowed
values are Continuous (high steady state),March
Code (high and low for even intervals), Temporal
(synchronized on a system basis, three even on/off
cycles followed by off period), and Panel Global
Pattern (will follow the panel pattern setting,
configured in the panel settings).

5. Enter a Duration to select how long an output will be
active. If set to 0, it will remain active until the system is
reset.
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SOM-A / VF6040-00,
SOM-AI / VF6041-00

Refer to Device Configuration for details about the options in
this window.

Channel Configuration

1. Select the desired Output Options. This selection will activate
the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each channel is
configurable in reaction to the Alarm Silence button on the front
panel. Check the box if the channel should return to normal
standby when Alarm Silence is active.

3. Each output circuit is SPST. Outputs are normally-open
(N.O.) and close upon activation. Selecting Output Invert will set
the output circuit to be normally-closed (N.C.); inverted outputs
open upon activation. During times of complete power loss (loss
of both normal and backup power), all outputs will open
regardless of their configuration settings. Inverting an output
does not change the quiescent current consumption of the panel
module.

4. Ignore Global Delays. This setting controls the delay of the
activation of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked, it will
activate based on the settings in the First Delay and Second
Delay fields. Second Delay is only visible if the output is
silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on the settings
in the First Delay field.
- if the output is silenceable, subsequent re-sounding of the output will
be delayed based on the settings in the Second Delay field.

5. Set the Pattern using the drop-down box. Allowed values are
Continuous (high steady state),March Code (high and low for
even intervals), Temporal (synchronized on a system basis,
three even on/off cycles followed by off period), and Panel
Global Pattern (will follow the panel pattern setting, configured in
the panel settings).

6. Enter a Duration to select how long an output will be active. If set
to 0, it will remain active until the system is reset.
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SRM
1. Set the Circuit Configuration that corresponds to the

terminals being used.
2. Set the Coil Type. Select the option that corresponds

to the connected coil type.
3. Set Solenoid Supervision to enable supervision on

the solenoid coil.

Pull Stations

AMS Pull Stations / VF3029-10
1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.
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Sensors

ACA-V / VF2008-00,
ACC-V / VF2012-00

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on the
selected Input Action. If desired, a custom message can be
entered.

3. Set the Input Delay, up to 180 seconds. This delays the panel's
response to an activation. No response will occur if the input
state is restored to normal before time period expires. A non-
latching input will not activate if restored before the time period
expires.

4. Check the Output Delay Bypass box if activation of this circuit
should immediately activate its associated outputs, even if those
outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level.

l When %/ft Multi or%/ft Optical are selected , allowed values are
0.88 - 3.57 (2.5 is the default).

l When F Heat is selected, allowed values are 32 - 158 (135 is the
default).

2. If%/ft Multi is selected, set the Multi Mode Heat Sensitivity for
Day and Night. Allowed values are 135 (default) - 150.

3. Check the Pre Alarm check box to cause a warning at the main
panel that the detector is near activation. When the smoke
density reaches the warning threshold, the sensor enters the pre-
alarm condition. The panel will indicate this state on the panel
GUI without initiating an alarm on the system. This will allow time
to investigate a false alarm or potential fire.

4. Check the Polling LED Flash check box to flash a green LED
when the sensor is being polled by the panel. If it responds as
expected, the sensor is connected and operating as expected. If
the sensor reports any issues, the panel will indicate a Trouble
condition.

5. An informational icon under Sounder Base will indicate whether
a base has been installed on this sensor.
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ACD-V / VF2014-00

Input Properties

1. Choose an Input Action for the Smoke Sensor ONLY.
The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Mode. This sensor can be set to one of 16 modes. Use the
Day and Night drop-down boxes to set the desired mode.
The other fields in this window rely on this setting to be
active or grayed out.

NOTE For more detailed information on thesemodes,
including when to use eachmode, refer to the Fire Alarm
Sensor - Mode Information and Selection Guide.

2. Alarm Value. This section of the window contains Day and Night fields for each part of the available modes. Set the
desired value in each field.

S/H/CO S/H Smoke CO/H CO H(FT) H(RoR) COHb
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Allowed Value Range 4* 3* 1 - 3.5 4* 3 - 15 135 - 150 27* 6.2*
Default Value 4 3 3 4 4 135 27 6.2

3. Pre-Alarm Value . This section of the window contains the settings for activation a pre-alarm condtion.
Set the desired value in each field.

S/H/CO S/H Smoke CO/H CO H(FT) H(RoR) COHb
Allowed Value Range 3.5* 2.5* 1 - 3.5 3.5* 3 - 15 120 - 150 27* 5.2*
Default Value 3.5 2.5 2.5 3.5 3.5 120 27 5.2
* This field is for informational purposes only. This value is not editable.

4. Polling LED. This LED flashes green when the sensor is being polled by the panel. If it responds as expected, the
sensor is connected and operating as expected. If the sensor reports any issues, the panel will indicate a Trouble
condition.
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AIE-EA / VF2001-00

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on the
selected Input Action. If desired, a custom message can be
entered.

3. Set the Input Delay, up to 180 seconds. This delays the
panel's response to an activation. No response will occur if the
input state is restored to normal before time period expires. A
non-latching input will not activate if restored before the time
period expires.

4. Check the Output Delay Bypass box if activation of this circuit
should immediately activate its associated outputs, even if
those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. Options are
Low, Normal, and High.

2. Check the Pre Alarm check box to cause a warning at the
main panel that the detector is near activation. When the
smoke density reaches the warning threshold, the sensor
enters the pre-alarm condition. The panel will indicate this
state on the panel GUI without initiating an alarm on the
system. This will allow time to investigate a false alarm or
potential fire.

3. An informational icon under Sounder Base will indicate
whether a base has been installed on this sensor.
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ALG-V / VF2002-00

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable range is 0.9 - 3.5%/ft.

2. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.

3. An informational icon under Sounder Base will
indicate whether a base has been installed on this
sensor.
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ALK-V / VF2005-00

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable range is 0.5 - 3.8%/ft.

2. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.

3. Check the Polling LED Flash check box to flash a
green LED when the sensor is being polled by the
panel. If it responds as expected, the sensor is
connected and operating as expected. If the sensor
reports any issues, the panel will indicate a Trouble
condition.

4. An informational icon under Sounder Base will
indicate whether a base has been installed on this
sensor.
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ALN-V / VF2011-00

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable range is 0.7 - 4%/ft.

2. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.

3. Check the Polling LED Flash check box to flash a
green LED when the sensor is being polled by the
panel. If it responds as expected, the sensor is
connected and operating as expected. If the sensor
reports any issues, the panel will indicate a Trouble
condition.

4. An informational icon under Sounder Base will
indicate whether a base has been installed on this
sensor.
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ATG-EA / VF2003-00

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable range is 32 - 158°F.

2. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.

3. An informational icon under Sounder Base will
indicate whether a base has been installed on this
sensor.
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ATJ-EA / VF2010

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response
will occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable range is 32 - 194°F.

2. Set the Day and Night Mode. This sensor can be set
to Fixed Temperature only or a combined mode with
Fixed Temperature and Rate of Rise.

3. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.

4. Check the Polling LED Flash check box to flash a
green LED when the sensor is being polled by the
panel. If it responds as expected, the sensor is
connected and operating as expected. If the sensor
reports any issues, the panel will indicate a Trouble
condition.

5. An informational icon under Sounder Base will
indicate whether a base has been installed on this
sensor.
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DH99A, DH99AR / VF5013, VF5014

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable range is .88 - 2.75%/ft.

2. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.
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Output Properties

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active.

3. Set the Pattern using the drop-down box. Allowed
values are Continuous (high steady state),March
Code (high and low for even intervals), Temporal
(synchronized on a system basis, three even on/off
cycles followed by off period), and Panel Global
Pattern (will follow the panel pattern setting,
configured in the panel settings).

5. Enter a Duration to select how long an output will be
active. If set to 0, it will remain active until the system is
reset.

Disablements Properties

Check the box to add this device to aPlant Control
Output group.
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Sounders

ASB / VF7008,
ASBL / VF7005

Output Properties

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active.

3. Set the Pattern using the drop-down box. Allowed
values are Continuous (high steady state),March
Code (high and low for even intervals), Temporal
(synchronized on a system basis, three even on/off
cycles followed by off period), and Panel Global
Pattern (will follow the panel pattern setting,
configured in the panel settings).

4. Enter a Duration to select how long an output will be
active. If set to 0, it will remain active until the system
is reset.

Disablements Properties

Check the box to add this device to aPlant Control
Output group.
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Apollo Protocol
Audio Visual

VF5651-10 - XP95A Sounder Beacon Base
1. Select the desired Output Options. This selection will

activate the circuit when the selected event(s) occur.
2. Set whether the output will be Silenceable. Each

channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active.

3. Delay. This setting controls the delay of the activation
of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked,
it will activate based on the settings in the First Delay
and Second Delay fields. Second Delay is only visible
if the output is silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.
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VF5652-30 - Discovery Open Area Sounder Beacon
1. Select the desired Output Options. This selection will

activate the circuit when the selected event(s) occur.
2. Set whether the output will be Silenceable. Each

channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active.

3. Delay. This setting controls the delay of the activation
of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked,
it will activate based on the settings in the First Delay
and Second Delay fields. Second Delay is only visible
if the output is silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.

4. Sounder Volume. Use the drop-down to select the
desired volume of the sounder beacon. The default is
86db.

Output Properties

Select the desiredOutput Options. This selection will
activate the circuit when the selected event(s) occur.
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VF5656-00 - CO Sounder Base

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable options are Mode 1,Mode 2, and Mode 3.

2. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.

3. Check the Polling LED Flash check box to flash a
green LED when the sensor is being polled by the
panel. If it responds as expected, the sensor is
connected and operating as expected. If the sensor
reports any issues, the panel will indicate a Trouble
condition.
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Modules

VF5604 - Loop Powered Beam Detector

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable range is 77 - 158.

2. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.

3. Check the Polling LED Flash check box to flash a
green LED when the sensor is being polled by the
panel. If it responds as expected, the sensor is
connected and operating as expected. If the sensor
reports any issues, the panel will indicate a Trouble
condition.
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VF5608 - Mini Monitor Module,
VF5660 - XP95A Priority Mini Switch Monitor Module,
VF5661 - Mini Switch Monitor Module,
VF5662 - Standard Input Module,
VF5663 - Priority Input Module
VF5664 - Dual Priority Switch Monitor Module
VF5680 - Switch Monitor Unit - DIN Rail

Refer to Device Configuration for details about the
options in this window.

Input Properties

1. Choose a Device Setting from the drop-down list. The
default setting is Manual Pull Station.

NOTE This step must be done first, as it will affect
the remaining configuration selections.

2. Choose an Input Action. The default setting is Fire. For
the default device setting (Manual Pull Station), the
setting must be Fire. Other device settings will have
different allowable input actions available, based on each
device's capabilities and limitations.

3. Input Action Message is automatically set based on the
selected Input Action. If desired, a custom message can
be entered.

4. Check the Output Delay Bypass box if activation of this
circuit should immediately activate its associated outputs,
even if those outputs have configured delays.

5. Set the Input Delay in seconds, up to 180 seconds. This
setting delays the panel's response to an activation. No
panel response will occur if the input state is restored to
normal before time period expires. A non-latching input
will not activate if restored before the time period expires.

6. Set the Input Latch field to Latching or Non-latching.
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VF5665 - Input / Output Monitor Module,
VF5682 - Input / Output Module DIN-Rail

Refer to Device Configuration for details
about the options in this window.

Input Properties

1. Choose a Device Setting from the drop-down list. The
default setting is Manual Pull Station.

NOTE This step must be done first, as it will
affect the remaining configuration selections.

2. Choose an Input Action. The default setting is Fire.
For the default device setting (Manual Pull Station),
the setting must be Fire. Other device settings will
have different allowable input actions available, based
on each device's capabilities and limitations.

3. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Delay in seconds, up to 180 seconds.
This setting delays the panel's response to an
activation. No panel response will occur if the input
state is restored to normal before time period expires.
A non-latching input will not activate if restored before
the time period expires.

6. Set the Input Latch field to Latching or Non-latching.
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Output Properties

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active.

3. Delay. This setting controls the delay of the activation
of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked,
it will activate based on the settings in the First Delay
and Second Delay fields. Second Delay is only visible
if the output is silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.
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VF5666 - Supervised Output Module,
VF5681 - Switch Sounder Control Unit DIN-Rail

1. Select the desired Output Options. This selection will
activate the circuit when the selected event(s) occur.

2. Set whether the output will be Silenceable. Each
channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active.

3. Delay. This setting controls the delay of the activation
of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked,
it will activate based on the settings in the First Delay
and Second Delay fields. Second Delay is only visible
if the output is silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.
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VF5667 - Relay Output Module
Refer to Device Configuration for details about
the options in this window.

Output Properties
1. Select the desired Output Options. This selection will

activate the circuit when the selected event(s) occur.
2. Set whether the output will be Silenceable. Each

channel is configurable in reaction to the Alarm
Silence button on the front panel. Check the box if the
channel should return to normal standby when Alarm
Silence is active.

3. Delay. This setting controls the delay of the activation
of the output. If unchecked, it will activate based on the
Global Delay settings in the Panel Settings. If checked,
it will activate based on the settings in the First Delay
and Second Delay fields. Second Delay is only visible
if the output is silenceable.

NOTE If checked,
- the initial activation of the output will be delayed based on
the settings in the First Delay field.
- if the output is silenceable, subsequent re-sounding of
the output will be delayed based on the settings in the
Second Delay field.
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Pull Stations

VF3033-10 - Addressable Manual Pull Station
Refer to Device Configuration for details
about the options in this window.

Input Properties

1. Choose a Device Setting from the drop-down list. The
default setting is Manual Pull Station.

NOTE This step must be done first, as it will
affect the remaining configuration selections.

2. Choose an Input Action. The default setting is Fire.
For the default device setting (Manual Pull Station),
the setting must be Fire. Other device settings will
have different allowable input actions available, based
on each device's capabilities and limitations.

3. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Delay in seconds, up to 180 seconds.
This setting delays the panel's response to an
activation. No panel response will occur if the input
state is restored to normal before time period expires.
A non-latching input will not activate if restored before
the time period expires.

6. Set the Input Latch field to Latching or Non-latching.
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VF5683 - Call Point
1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.
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Sensors

VF5600 - Ionization Smoke Sensor Head,
VF5601 - Photoelectric Smoke Sensor Head,
VF5602 - Heat Sensor Head,
VF5603 - Multisensor Sensor Head,
VF5606 - Carbon Monoxide Detector Head

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable options are Mode 1,Mode 2, and Mode 3.

2. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.

3. Check the Polling LED Flash check box to flash a
green LED when the sensor is being polled by the
panel. If it responds as expected, the sensor is
connected and operating as expected. If the sensor
reports any issues, the panel will indicate a Trouble
condition.
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VF5668 - Heat Sensor,
VF5669 - Ionization Smoke Sensor,
VF5670 - Photoelectric Smoke Sensor,
VF5671 - Multisensor Sensor

Input Properties

1. Choose an Input Action. The default setting is Fire.

2. Input Action Message is automatically set based on
the selected Input Action. If desired, a custom
message can be entered.

3. Set the Input Delay, up to 180 seconds. This delays
the panel's response to an activation. No response will
occur if the input state is restored to normal before
time period expires. A non-latching input will not
activate if restored before the time period expires.

4. Check the Output Delay Bypass box if activation of
this circuit should immediately activate its associated
outputs, even if those outputs have configured delays.

5. Set the Input Latch field to Latching or Non-latching.

Sensor Properties

1. Set the desired Day and Night Sensitivity Level. The
allowable range77 - 158.

2. Check the Pre Alarm check box to cause a warning at
the main panel that the detector is near activation.
When the smoke density reaches the warning
threshold, the sensor enters the pre-alarm condition.
The panel will indicate this state on the panel GUI
without initiating an alarm on the system. This will
allow time to investigate a false alarm or potential fire.

3. Check the Polling LED Flash check box to flash a
green LED when the sensor is being polled by the
panel. If it responds as expected, the sensor is
connected and operating as expected. If the sensor
reports any issues, the panel will indicate a Trouble
condition.
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Adding Panels / Devices to a Network
Adding a panel or device to a network can be accomplished in two ways - through theWizard described in the
Configure Tab or by double-clicking the panel from the Device Selection Panel.

Add a Panel (without the Wizard)
1. To add a panel to the network, select the Network Overview (globe icon) in the Network Tree.
2. Right-click and select New PanelOR drag-and-drop the desired panel from the Panels pane at the bottom of the window.
3. Changes can be made to the default configuration using Edit Properties.

When new panels are added, LE2 will build a network tree based on the panel type.
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Add an SLC Device
1. Expand the network tree by clicking on the (+) button next to the panel name. This displays Loops, Panel I/O, and

Modules.
2. Select the loop on which to add the SLC device. A list of available devices is displayed in the bottom pane. If any devices

have been added to Favorites, a separate tab will appear called Favorites. Alternatively, drag-and-drop the items onto
the desired loop.
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Add Favorites
Addmodules or devices to favorites by right-clicking that device in the bottom pane and selectingAdd to
Favorites. This feature is only available for Modules and Devices.
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Add Multiple Devices of the Same Type
Right-click the desired device in the bottom pane and select the number of devices to add to the network,
between 1 and 9. If more than 9 are needed, clickAdd # New to config and enter the desired number of
devices to add to the network.
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Open Network File
Upon the launch of LE2, theOpen Network Filewindow is displayed. These are the options from that window:

l Create New File
l Open File
l Connect to Panel
l Exit

Open File andConnect to Panel create a new LE2 file and location path. For new site configurations, the
recommended option isCreate New File.

Create New File

WhenCreate New File is selected, a blank configuration file will be created. Panels and devicesmust be
manually added or tranferred to the panel. All panel settings, panel I/O, SLC devices, and peripherals added will
be configured with default LE2 settings, such as:

l Panel Name, such as Fire NET L@titude or RS Hochiki. This name can be changed by the user using the panel setting
configuration window.

l Strobe Sync Protocol A will be set to Wheelock. Strobe Sync Protocol B will be set to Gentex FACP
l General Alarm Mode will be set to Common.
l Panel NACs will be set to have a current limit of 2.5A, circuit timeout 250ms, and Class B.
l Panel I/O will be set to Zone 0.
l Added devices will be added to Zone 01.
l Default Ring Mode will be Resound for fire in the same or other zone enabled.

Because this option requires user input for unknown variables, the user must carefully configure each panel,
device, and panel module / peripherals with correct Address numbers and settings. If not configured properly,
the panel will display errors when the configuration is transferred.

A commonmistake with this selection is, for panels with a zone board, the user must select the number of zone
indicators on the board (48, 96, 144). If this isn't done, the user will have to send the configuration to the panel
again with the correction.

1. To create a new file, click File > New and enter a file name and save location when prompted. LE2 will display a blank
configuration page.
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ClickTools > Edit Preferences to begin setting global software preferences.

General Tab
1. If applicable, configure the Comm Port in use by the serial programming cable. Choose the applicable baud rate. The

Refresh icon may be used to check for other connected serial Comm Ports.

2. Configure Auto Save Preferences.

Display Options Tab
1. Set the Default Zone to Add Devices. This sets the zone where newly-added SLC devices will be automatically set.
2. Check all desired preferences.
3. Set the default Time Zone.
4. Click Save.

Begin building the network configuration by adding a panel to the network. Refer to Adding Panels / Devices to a
Network.
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Create a New File from an Existing File
For existing sites, it may be desired or necessary to create a new file using an existing one for the site.

1. Click Open in the File tab.
2. Locate the desired file. It may be displayed in the recently opened projects area. If not, use the file navigator to locate the

file.
3. Click Save As to make a copy of the file with a new name.
4. To edit the Network Site Details, right-click the global icon (the top of the network tree) and click Edit Properties. Edit the

desired site details and click Save.
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Connect to a Panel
The existing site configuration can be imported to LE2 if the current user does not have access to the original, or
if Autolearn will be used.

TheConnect to Panel option will prompt the user to choose a file name and save location before navigating to
the Transfer Configuration window. Because this option creates a new network file with a blank network site
tree, the user cannot send a configuration to the panel from LE2. This is prevented by graying the transfer to PC
button.
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Alarm Verification
AlarmVerification is a zone-based feature of automatic fire-detection and alarm systems to reduce unwanted
alarms. Alarm conditions are reported or confirmed for aminimum time period in order to be accepted as a valid
alarm.

NOTE Legacy panels have limitations on alarm verification.

1. Right-click the Network Overview level (shown below) and click Edit Properties.

2. The Network Site Details window will appear. Select the desired setting from the Alarm Verification drop-down list and
click Save.
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3. Navigate to Configure > Zone Manager.
4. Double-click the zone number to assign to the Alarm Verification zone selection. The Zone Detail window will appear.

5. Click the Alarm Verification Enabled checkbox and click Save.
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Bridge Networking
This enables backwards compatibilitymode on newer FACPs. To use bridge networking, theremust be a legacy
product (FireNET or FireNET+) on the same network as a new series of FACP (FireNET L@titude).

1. Open the site network configuration file that holds the configuration for the legacy units.
2. Add a new panel to the existing network configuration. The newly added unit will automatically be entered into bridge

mode.

When a legacy panel is added, the panel type can be changed using the network tree. Right-click on the legacy
panel and clickConvert Panel To:. Select the desired panel type.
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When panels are in bridgemode, some features are altered tomatch the capabilities of the legacy products. For
example, legacy panels are restricted to 4 loops and 500 zones.

Hochiki America Corporation
Loop Explorer 2 User Guide

Version 1.00 |   June 2021 |   MAN-701
Page 222

CommonProcedures



INDEX
2

24V 95, 142

A

AUX 24V 142

B

Buzzer 60, 116

C

Class A 111, 141, 177

Class B 41, 111, 141, 177, 215

E

Event Log 32, 60, 81, 115

F

Fire Relay 41

Fire Routing Input 41

Fire Routing Output 2 41

H

Heartbeat 153

L

Loop Explorer 2 16, 96

N

Network 14, 21, 25, 39, 51, 81, 106, 141, 167, 211

P

Panel Tests 60

Printer 32, 94

S

SLC 30, 40, 63, 90, 109, 212

T

Terminals 184

Trouble Relay 41, 163

Trouble Routing Input 41

Trouble Routing Output 41

Z

Zone LED 107

Hochiki America Corporation
Loop Explorer 2 User Guide

Version 1.00 |   June 2021 |   MAN-701
Page 223

Index



GLOSSARY

.

.csv
A Comma Separated Values (CSV) file is a plain text file that contains a list of data, sep-
arated by commas. This is very commonly opened in a spreadsheet.

.lx9
The file format for LE1 configuration files.

.nle
The file format for LE2 configuration files.

.pdf
PDF stands for Portable Document Format, used to display documents in an electronic
form, typically within Adobe Acrobat.

.xls
This is a Microsoft spreadsheet file, opened in MS Excel.

.xml
XML is a markup language to define a way to encode documents that both humans and
machines could read. It does this through the use of tags that define the structure of the doc-
ument, as well as how the document should be stored and transported. This is typically
opened in a browser.
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